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PREFACE 
 

This book entitled “IT WORKSHOP Lab” is intended for the use of  Second year First 

semester (i.e, II-I) B.Tech(CSE) students of Marri Laxman Reddy Institute of Technology 

and Management, Dundigal, Hyderabad. The main objective of The IT Workshop is a 

training lab course to get training on PC Hardware, Internet & World Wide Web, and 

Productivity tools for documentation, Spread sheet computations, and Presentation. 
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GENERAL INSTRUCTIONS 

 

 
1. Students are instructed to come to It Workshop laboratory on time. Late comers are not entertained in the lab.  

 

2. Students should be punctual to the lab. If not, the conducted experiments will not be repeated.  

 

3. Students are expected to come prepared at home with the experiments which are going to be performed.  

 

4. Students are instructed to display their identity cards before entering into the lab.  

 

5. Students are instructed not to bring mobile phones to the lab.  

 

6. Any damage/loss of system parts like keyboard, mouse  during the lab session, it is student’s responsibility and 

penalty or fine will be collected from the student.  

 

7. Students should update the records and lab observation books session wise. Before leaving the lab the student 

should get his lab observation book signed by the faculty.  

 

8. Students should submit the lab records by the next lab to the concerned faculty members in the staffroom for 

their correction and return.  

 

9. Students should not move around the lab during the lab session.  

 

10. If any emergency arises, the student should take the permission from faculty member concerned in written 

format.  

 

11. The faculty members may suspend any student from the lab session on disciplinary grounds.  

 

12. Never copy the output from other students. Write down your own outputs.  
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INSTITUTION VISION AND MISSION 

 

 

 
VISION  
To establish as an ideal academic institutions in the service of the nation, the world and the humanity by 

graduating talented engineers to be ethically strong, globally competent by conducting high quality research, 

developing breakthrough technologies, and disseminating and preserving technical knowledge.  

 

 MISSION  

To fulfill the promised vision through the following strategic characteristics and aspirations:  

➢ Contemporary and rigorous educational experiences that develop the engineers and managers.  

➢ An atmosphere that facilitates personal commitment to the educational success of students in an environment 

that values diversity and community.  

➢ Undergraduate programs that integrate global awareness, communication skills and team building.  

➢ Education and Training that prepares students for interdisciplinary engineering research and advanced 

problem solving abilities.  
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DEPARTMENT VISION AND MISSION 

 
 

Department Vision: 
 

To empower the students to be technologically adept, innovative, self-motivated and responsible global 

citizen possessing human values and contribute significantly towards high quality technical education 

with ever changing world. 

 

Department Mission: 
 

 To offer high-quality education in the computing fields by providing an environment where the 

knowledge is gained and applied to participate in research, for both students and faculty. 

 To develop the problem solving skills in the students to be ready to deal with cutting edge 

technologies of the industry. 

 To make the students and faculty excel in their professional fields by inculcating the communication 

skills, leadership skills, team building skills with the organization of various co-curricular and extra-

curricular programmes. 

 To provide the students with theoretical and applied knowledge, and adopt an education approach 

that promotes lifelong learning and ethical growth. 

                                                                                    

Program Educational Objectives:  

PEO1: Establish a successful professional career in industry, government or academia. 

PEO2: Gain multidisciplinary knowledge providing a sustainable competitive edge in higher 

studies or Research. 

PEO3: Promote design, analyze, and exhibit of products, through strong communication, leadership and 

ethical skills, to succeed an entrepreneurial. 

 

Program Specific Outcomes 

PSO1:  Applications of Computing: Ability to use knowledge in various domains to provide solution 

to new ideas and innovations. 

PSO2:  Programming Skills: Identify required data structures, design suitable algorithms, develop and 

maintain software for real world problems. 

v 
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PROGRAM OUTCOMES 

 

The Program Outcomes (POs) of the department are defined in a way that the Graduate 

Attributes are included, which can be seen in the Program Outcomes (POs) defined. The 

Program Outcomes (POs) of the department are as stated below: 

a :   An ability to apply knowledge of Science, Mathematics, Engineering & Computing 

fundamentals for the solutions of Complex Engineering problems. 

b :  An ability to identify, formulates, research literature and analyze complex engineering 

problems using first principles of mathematics and engineering sciences. 

c :  An ability to design solutions to complex process or program to meet desired needs. 

d :  Ability to use research-based knowledge and research methods including design of 

experiments to provide valid conclusions. 

e :  An ability to use appropriate techniques, skills and tools necessary for computing practice. 

f :  Ability to apply reasoning informed by the contextual knowledge to assess social issues, 

consequences & responsibilities relevant to the professional engineering practice. 

g :  Ability to understand the impact of engineering solutions in a global, economic, 

environmental, and societal context with sustainability. 

h :  An understanding of professional, ethical, Social issues and responsibilities. 

i :  An ability to function as an individual, and as a member or leader in diverse teams and in 

multidisciplinary settings. 

j :  An ability to communicate effectively on complex engineering activities within the 

engineering community. 

k :  Ability to demonstrate and understanding of the engineering and management principles as 

a member and leader in a team. 

l :  Ability to engage in independent and lifelong learning in the context of technological 

change. 
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Course Objectives 

 
 To assemble and disassemble a computer. 

 To solve hardware and software problems. 

 To develop project documentation using ms word and latex . 

 To work with excel spread sheet for different calculations. 

 

 

Course Outcomes 
 Apply knowledge for computer assembling and software installation. 

 Able to understand how to solve the trouble shooting problems. 

 Apply the tools for preparation of PPT, Documentation and 

 Able to understand the Linux Environment. 

 

 

LEARNING OUTCOMES 

On the successful completion of the lab student will be capable of 

1. Be able to build their own PC and able to solve Software and Hardware problems. 

2. Demonstrate proficiency in Microsoft Office and Windows. 

3. To acquire hands-on experience in OS installation. 

4. Be able to assist in the creation of an effective  Power point presentation. 

5. Be able to assist in the creation of an effective  Excel sheets. 
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Content of Lab Experiments 

Problem 1: 

Every student should identify the peripherals of a computer, components in a CPU and its functions. Draw the 

block diagram of the CPU along with the configuration of each peripheral and submit to your instructor. Every 

student should disassemble and assemble the PC back to working condition. 

i). AIM: To Identify the peripherals of a computer, components in a CPU and its functions and to draw the block 

diagram of the CPU along with the configuration of each peripheral.To assemble an disassemble the PC back to 

working condition.. 

Hardware Requirements: Cabinet, Hard Disk, CD/DVD Drive, Floppy Drive, Monitor, Mouse, Keyboard, Mother 

Board, Socket 478, Processor, Heat Sink Fan, RAM Slots, PCI Slot, AGP Slots, CMOS Battery, BIOS, North Bridge, 

South Bridge, IDE Slots, SMPS, ATX power Connector. 

Software Requirements: Not Required 

INTRODUCTION TO COMPUTER:   

A computer is a programmable machine or computer is an electronic device which takes the input information from 

the input device, process or executes the input in Processor or CPU and generates the output information through 

output devices.  Computer enables arithmetic computations, data processing, information management (storage) and 

knowledge reasoning in an efficient manner.   

BLOCK DIAGRAM OF COMPUTER 

 

Basically the computer system has three major components. These are  

1. Central Processing Unit (Processor) 

2. Input and Output Unit. 

3. Memory Unit (Main Memory and Auxiliary storage). 
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1. CENTRAL PROCESSING UNIT: 

The Central Processing Unit takes the input data from the input devices and processes it according to the set 

of instructions. After that generate the output and sends the output to the output devices. The CPU is composed three 

parts. These are 

 

a) ALU: 

            Arithmetic Logical Unit (ALU) is used to do the arithmetic operations on data by adding, subtracting, dividing, 

multiplying and incrementing and decrementing. 

It is also used for Logical operations like AND, OR, NOT and X-OR. 

b) CU: 

            Control unit is mainly used for generating the electronic control & timing signals for program execution. It 

controls all the operations of the computer. 

c) Registers: 

            CPU also possesses the memory to hold the data temporarily during the execution of an instruction. These are 

small memory locations in CPU. 

2. INPUT AND OUTPUT UNIT: 

INPUT DEVICE: 

            Input devices accept the data and instructions from the user. 

Ex: Mouse, Scanner, Keyboard, joysticks, digital cameras, microphones, etc… 

OUTPUT DEVICE: 

            Output devices return the processed data back to the user. 

Ex: Monitor, Printer, etc… 

3. MEMORY UNIT: 

Memory is like an electronic scratch pad inside the computer. It is a storage unit to hold the data. 

            In the computer the data will be stored and retrieved in the form of bits and bytes. The byte will store a single 

character such as a letter of the alphabet or a numeral. 

a)    8 BITS = 1 BYTE 
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b)    1024 BYTES = 1 KB 

c)     1024 KB = 1 MB 

d)   1024 MB = 1 GB 

e)    1024 GB = 1 TB. 

The memory can be classified into two categories. These are 

    I.      primary or main memory 

    II.      Secondary or auxiliary memory 

I. PRIMARY OR MAIN MEMORY: 

Primary memory is the fastest memory in a computer. This memory is primarily (temporarily) used to store the data 

and programs during the execution of a program. 

Primary memory is classified into two categories called 

a)    Random Access Memory (RAM) 

b)    Read Only Memory (ROM)\ 

 

II. SECONDARY OR AUXILIARY MEMORY: 

            Secondary memory used to store the data permanently. The data will be stored in storage devices. Storage 

devices are like Magnetic disks, Hard disks, Floppy disks, Compact disks 

 

IDENTIFICATION OF PERIPHERALS:  

1. Cabinet:  

It is used to install all hardware devices like (Mother Board, SMPS, HDD, CD ROM, and FDD). It has Start, 

Restart Button, Led’s, Audio and USB Connecters are available at front side.  
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2. The Mother Board/ System Board 

In Personal Computers, a Mother Board is the central printed circuit Board (PCB) in many modern 

computers and holds many of the crucial components of the system, providing connectors for other 

peripherals. It is also called as main board or system board. 

Classification of Mother Boards: 

1) Integrated Mother Boards have all the peripheral device slots, input output ports, serial and parallel 

ports are mounted on the board. 

2) Non-Integrated Mother Boards have all peripheral device slots and input output ports,, serial and 

parallel ports are connected using expansion Boards. 

List of Mother Board Manufactures are: Intel, Zebronics, Acer Inc.,VIA Technologies, etc. 

 

 

Mother Board 

Mother Board Parts: 

a) Socket 478: It has 478 pin slots to place the CPU in it and above the CPU place the Heat Sink Fan to cool 

the processor when it generates the heat and we can fix the fan with locks. 
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b) CPU or Processor 

CPU The central processing unit contains the heart of any computer, the processor. The processor is fitted on 

to a Mother Board. The Mother Board contains various components, which support the functioning of a PC. 

Clock Speed measures how fast a processor completes operations, usually measured in megahertz and 

gigahertz. A 1.8GHz processor runs at 1,800,000,000 cycles per second. List of CPU Manufacturers are: 

AMD, INTEL, Samsung, IBM, Transmeta, etc 

 

 

 

 

 

 

       Heat Sink Fan 

 

c) RAM Slots and RAMs 

RAM Slots are used to place the RAM Cards. RAMs are used to increase the processing speed the system 

to run application more effectively, and it has temporary memory. We have two types of RAMs 

i) SD RAM (Synchronous Dynamic), it has two Gaps/Notche 

ii) DDR RAM (Double Data Rate), it has one Gap/Notch 

 

 

 

 

 

       DDR RAM 
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    SD RAM 

 

 

 

Manufactures of RAM’s are Transcend, Kingston, Micron, Hynix, etc.  

d) North Bridge: 

It is also called as controller. It converts electronic signals to binary values and binary values to electronic 

signals.  

 

 

 

 

 

e) South Bridge: 

It is controls major components of mother board and it is a back bone of the input out devices. It is 

communicates PCI slots, IDE-1, IDE-2, floppy connecter, BIOS chip. 

 

 

 

 

 

f) CMOS (Complementary Metal Oxide Semiconductor)  Battery 

Computer is using a coin shape battery. It generates the clock signal and it manages system time 

continuously.  
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g) Primary & Secondary(IDE-1 & IDE-2) : 

Mainly there are three IDE slots and cables i.e. IDE-1 (Primary) to connect Hard Disk Drive having 40 

pin slot and 80 wire cable, IDE-2 (Secondary) to connect CD/DVD Drive having 40 pin slot and 40 wire 

cable, IDE-3 (Tertiary) to connect Floppy Drive having 35 pin slot 3.5inch wire with a cut in middle. But 

present mother boards does not have IDE-3 slot. 

 

h) Input & Output ports : 

I/O ports are used to connecting I/O device such as key boards, mouse, monitor, printer, scanner, speakers 

etc... 

 

i) AGP Slot & AGP Card : 

Accelerated Graphic Port (AGP) Slot is used install the AGP card. AGP back view same as VGA port 

(15-pins) and used to connecting the monitors. 

 

j) PCI(Expansion) Cards, PCI Slots : 

PCI (Peripheral Component Interconnect) slots are used to place the PCI cards such as LAN (Ethernet) 

Card, Sound Card, TV Tuner Card, etc. 

 

 LAN Card                           Sound Card                                TV Tuner Card 
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k) BIOS Chip : 

BIOS (Basic Input Output System) controls how the operating system and hardware wok together and 

manages all the hardware devices installed in mother board. 

 

 

 

l) ATX Power connecter Slot: 

ATX (Advanced Technology Extended) power connector slot used to place the ATX power connector 

from SMPS to supply the power to motherboard. 

 

 

 

 

3. SMPS (Switched mode Power Supply) 

To supply the power to all the components inside the cabinet and it is a case that holds a transformer, voltage 

control and fan. 

 

 

 

 

            4. HDD (Hard Disk Drive) 

HDD is a device for storing and retrieving digital information, primarily computer data. It consists of rotating 

discs (often referred to as platters), coated with magnetic material and with magnetic heads arranged to write 

data to the surfaces and read it from them. 

 

List of Manufacturers of HDD Devices are: Hitachi, Samsung, Toshiba, Seagate Technology 
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5. CD-ROM Drive/ DVD ROM Drive 

CD Drive the most common type of removable media. 

The common types are: CD-ROM, CD-RW, CD-R, DVD, DVD-ROM.,  DVD-RW,  DVD-R 

 

 

 

 

 

 

 

6. Different Screws Used: 

A Computer system has three kinds’ screws 

i) Mother Board Screws (Small Size) 

ii) HDD, CD/DVD, FDD Drive Screws (Medium Size) 

iii) Outer screws to fix sides of cabinet (Large Size) 

 

Result: Introduction to computers and Identification peripherals task completed. 
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 AIM: TO assemble and disassemble the system 

Hardware Requirements: Cabinet, Hard Disk, CD/DVD Drive, Floppy Drive, Monitor, Mouse, Keyboard, Mother 

Board, Processor, Heat Sink Fan, RAM Cards, PCI Cards, AGP Card, CMOS Battery, IDE cables, SMPS, ATX 

power Connector. 

Software Requirements: Not Required 

Safety Precautions: 

1. Beware of electrostatic discharge (ESO) 

2. Build computer on a hard surface, away from concepts. 

3. Wear shoes and the short sleeved cotton wear. 

4. Use Phillips, head screw driver. 

5. Keep the components away from moisture. 

6. Avoid using pressure while installing. 

Steps for Assembling: 

1. Setting the cabinet ready. 

2. Preparing to fit the components. 

3. Fitting the mother board. 

4. Fitting the RAM, processor and cooler. 

5. Installing PCI cards. 

6. Fitting the hard disk and floppy drive. 

7. Installing the CD ROM drives. 

8. Connecting the ribbon cables. 

9. Powering the drives and mother board. 

10. Connecting the cables for the case front panel. 

11. Final check. 

Getting the Cabinet ready:- 

1. Check how to open the cabinet and determine where to fix the components. 

2. Determine if the case has the appropriate risers installed. 

 

 

Preparing to fit the 

Components: 

1.  

Network adapter drive. 
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2.  Floppy disk drive. 

3.  BUS cables. 

4.  Hard disk. 

5.  CD-ROM Drive. 

6.  RAM 

7.  CPU 

8.  Heat sink / cooler / fan. 

9.  Mother board. 

10.  Screws. 

Fitting the Mother board: 

1. Line up the patch on the motherboard with the appropriate holes in the block panel I/O shield of the case. 

2. Check the points where you and to install 

3. Install them and make the mother board sit on them and fix screws if required 

 

 

 

 

 

Fitting the processor: 

   1. Raise the small lever at the side of the socket. 

  2. Notice that there is a pin missing at one corner, determine the direction to fit in the processor. 

3. You should not force the CPU. When inserting it. All pins should slide smoothly into the socket. 

4. Lock the lever back down. 

5. Install the heat sink over it (Different type for each processor). Heat sink / CPU fan.  

 

 

Fitting the RAM: 

1. The RAM must be suitable for motherboard. 
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2. There are currently 2 types of RAM available. 

a) SD RAM. 

b) DDR RAM. 

3. The mother board’s chipset determines which type of RAM may be used. 

 

 

 

 

 

Installing the PCI Cards: 

1. Most of the cards are inbuilt these days. 

2. Network Interface Cards, Sound Cards etc. are fitted into PCI slots. 

Fitting the hard disk and Floppy disk: 

1. Place the floppy and hard disks in their slots. 

2. Leave some space above HDD to prevent heat building. 

3. Check the jumper configuration. 

4. Fix the screws. 

 

 

 

 

 

Installing the CD- ROM Drives: 

1. CD-ROM drive is similar to installing a hard disk. 

2. 1ST check that the jumper configuration is correct. 

3. Fix the screw. 
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Connecting the BUS Cables, power connectors:- 

1. Attach the long end of the cable to the IDEU connector on the motherboard first. 

2. The red stripe on the IDE cable should be facing the CD Power. 

 

Final Check:- 

1. Mother board jumper configurations are the settings for the processor operator. 

2. Drive jumper settings, master/ slave correct? 

3. Is the processor, RAM modules and plug in cards finally seated in their sockets? 

4. Did you plug all the cables in? Do they all fit really? 

5. Have you frightened all the screws in plug- in cards or fitted the clips? 

6. Are the drive secure? 

7. Have u connected the power cables to all driver? 

 

 

 

 

 

 

 

 

 

Result: Introduction to computers and Identification peripherals task completed.  Assembling and disassembling 

procedure is successfully completed. 
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Viva Questions: 

1) What is a computer? 

Ans: Computer is a  electronic device which receive, stores ,process the data and gives output  

 

2) What are the different functions of a computer? 

Ans: A computer does the following functions; 

a) Accepting data 

b) Processing Data 

c) Storing Data 

d) Displaying Data 

 

3)    How a minicomputer different from a mainframe? 

Ans: Minicomputer is a midsized multiprocessing and multi user computer. It is also called mid-range 

server. But mainframes are huge computers, most commonly occupying entire rooms or floor. It is highly 

costly.  

 

4)    What is Super computer? 

      Ans: The fastest type of computer. Supercomputers are very expensive and are employed for 

specialized applications that require immense amounts of mathematical calculations. For example, weather 

forecasting requires a supercomputer. Other uses of supercomputers include animated graphics, fluid 

dynamic calculations, nuclear energy research, and petroleum exploration. 

 

5)    Differentiate Input and Output device. 

Ans: Input devices are used for giving input to the computer. But output devices are used to get the result 

back from the computer. The examples of input devices are keyboard, mouse, scanner, digital camera 

atc...whereas output devices include monitor, printer, projector etc.... 

 

6)    What is a storage device? What is the common classification? 

Ans:Storage devices are used to store data in the computer. The different types of storage devices are; 

a) Magnetic Devices. 

b) Optical Devices. 

c) Solid-State Storage Devices. 

                             

7)    What do you mean by a processing device? What are the various types of processing devices? 

Ans:The main function of a computer is to process data. The various types of processing device in a 

computer are; 

a) Microprocessor 

b) Chipset 

c) BIOS 

 

 

8)    Differentiates Serial and Parallel port. 

Ans:Serial port and parallel port are used for transferring data in/out of the computer. In serial port 

transmission only 1 bit is transmitted at a time. Most serial ports on personal computers conform to the RS-

232C or RS-422 standards. A parallel interface for connecting an external device such as a printer. On PCs, 

the parallel port uses a 25-pin connector (type DB-25) and is used to connect printers, computers and other 

devices that need relatively high bandwidth. It uses parallel transmission of data. 

 

9) What is an interface? 

Ans:These are the communication channel that enables your computer to exchange information with 

various devices. 

http://www.webopedia.com/TERM/C/computer.html
http://www.webopedia.com/TERM/A/application.html
http://www.webopedia.com/TERM/G/graphics.html
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10) What is a microprocessor? 

Ans:The most important electronic component on the computer. It is a programmable logical device for 

processing data. In the world of personal computers, the termsMICROPROCESSOR and CPU are used 

interchangeably. 

 

11) What are the factors affecting the speed of the microprocessor? 

Ans:The following are the factors affecting the speed of the microprocessor. 

a) Number of instructions build in the processor. 

b) Bandwidth 

c) Clock Speed 

d) Number of transistors inside the processor 

 

12) What are the differences between Multitasking and Multiprocessing? 

Ans: Multitasking- Enables the processor to do multiple programs simultaneously by fast switching 

 through the programs. Here doesn't have the involvement of multiple processors. 

Multiprocessing- Enables the processor to do multiple programs simultaneously by the use of multiple 

processors. 

 

13) What the difference between FSB and BSB? 

Ans:Front Side Bus. Another name for the system bus. The Front Side Bus connects the CPU to main 

memory. A microprocessor bus that connects the CPU to aLevel 2 cache is called Back Side Bus. 

Typically, a backside bus runs at a fasterclock speed than the Front Side Bus. 

 

14) What is CISC and RISC? 

Ans:Reduced Instruction Set Computer (RISC) and Complex Instruction Set Computer (CISC) are two 

philosophies by which computer chips are designed. RISC became a popular technology buzzword in the 

1990s, and many processors used in the enterprise business segment were RISC-based. 

 

 

15) What is full name of AMD? 

Ans:Advanced Micro Devices. 

 

 

16) What is Heat Sink? What is its use? If it is not in the system what will happen? 

Ans:A heat sink is a component used to lower the temperature of a device.It is most commonly there on the 

microprocessor. If it is not properly fixed the system, the system will shutdown automatically to prevent 

further damage to the processor. 

 

17)  A CPU fan should be placed in system. Why? 

Ans:To make the system cool and more functioning. 

 

18) What is Upgrading a microprocessor? Why we have to do it? 

Ans:Upgrading a microprocessor is just physically replacing a processor with a new one. Before doing so 

we have to make sure that the processor we want to use for your upgrade is physically compatible with the 

socket on your computer's motherboard. We also have to make sure that the motherboard has the internal 

logic to support the processor. 

 

19) What is main memory in a computer? 

Ans:The main memory in a computer is called Random Access Memory. It is also known as RAM. This is 

the part of the computer that stores operating system software, software applications and other information 

http://www.webopedia.com/TERM/P/personal_computer.html
http://www.webopedia.com/TERM/S/system_bus.html
http://www.webopedia.com/TERM/F/frontside_bus.html
http://www.webopedia.com/TERM/M/main_memory.html
http://www.webopedia.com/TERM/M/main_memory.html
http://www.webopedia.com/TERM/B/bus.html
http://www.webopedia.com/TERM/C/CPU.html
http://www.webopedia.com/TERM/L/L2_cache.html
http://www.webopedia.com/TERM/C/clock_speed.html
http://www.webopedia.com/TERM/F/frontside_bus.html
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for the central processing unit (CPU) to have fast and direct access when needed to perform tasks. 

 

20)What is Cache memory? What is the advantage if a processor with more cache memory you are 

using? 

Ans:Cache memory is the memory area between RAM and Processor. If cache memory increases the speed 

of the system will also improved. 

21)  What is the name of the printed circuit board? 

Ans.Motherboard 

22) Which Component of pc maintains data and time 

Ans:CMOS 

23)  What is the name of the card that controls read,write head and motor in the hard disk 

 Disc Controller Card 

24)  Which of the following retains the information it's storing when the power to the system is turned 

off? 

ROM 

25) Acronym of HDD? 

Hard Disk Drive 

26) How many bytes a sector of hard disk holds? 

512 Bytes 

27) What does FDISK do? 

creates partitions on the hard drive 

28) What is BIOS an acronym for? 

 basic input output system 

29) What does the acronym bits stand for? 

 Binart Digit 

30)  Today's PC use what type of RAM..? 

DDR SDRAM 

31) What is memory bank? 

Ans: Sets of physical memory modules is referred to as memory banks. A memory bank serves as a 

repository for data, allowing data to be easily entered and retrieved. 

 

32) What we need to consider before connecting a memory to the system? 

Ans: a)    Capacity of the RAM required 

         b)    Check if installed memory is supported by motherboard and processor 

         c)    Form factor of the RAM         d)    Type of RAM needed         e)    Warranty of the RAM 

 

http://www.techterms.com/definition/memorymodule
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33)What is Upgrading the memory? 

Ans: Adding a memory module to the existing bank on the available slot or replacing the previous one with 

the increased memory size is also called upgrading memory. This will surely increase the performance of 

the computer. 

 

34) What is BIOS beep code? What it does mean? 

Ans:BIOS beep codes are the signs of different issues of the computer. The beep code may vary depends on 

the manufacture of BIOS. For example in case of Award BIOS the beep code will be, 

1 long beep- shows memory problem 1 long beep and 2 short beeps- failure of DRAM parity 

1 log beep and 3 short beeps- signifies Video error 

Continuous beep- signifies failure in memory or Video memory. 

 

35) What is RDRAM? 

Ans:Short for RAMBUS DRAM, a type of memory (DRAM) developed by Rambus, Inc. 

 

36) What is SIMM? Is it is using now? 

Ans:Acronym for Single In line Memory Module, a small circuit board that can hold a group 

of memory chips. Typically, SIMMs hold up to eight (on Macintoshes) or nine (on PCs) RAM chips. On 

PCs, the ninth chip is often used for parity error checking. Unlike memory chips, SIMMs are measured 

in bytes rather than bits. 

Now a days this memory module is not used. 

 

37) Why do we call motherboard a motherboard? 

Ans:Motherboard is the basic integrated board of the computer on which all other components are 

connected. So that usually we call motherboard a "motherboard". 

 

38) What is motherboard? What are the different types of it? 

Ans:Motherboard is the basic integrated board of the computer on which all other components are 

connected. This is classified mainly into three Desktop, Laptop and Server motherboard. 

 

39) What is the difference between integrated and non-integrated motherboard? 

Ans:In integrated motherboard all of the external ports will be present. But in case of  non-integrated 

motherboard only some important ports will be available instead of all. The non-integrated motherboard is 

an old type of motherboard which now a day's not commonly available. 

 

40) How a server motherboard different from a desktop? 

Ans:A server motherboard is different from a desktop in features and performance. The number of 

processor support, RAM slots ,Expansion card slots etc...are more. For example the Intel® Server 

Board S5000PSL has the performance and features for growing businesses demand. It provides excellent 

data protection, and advanced data management. It support 64-bit Multi-Core Intel® Xeon® 

processor. Eight fully buffered 533/667 MHz DIMMs. Up to six SATA 3Gb/s ports. 

 

41) What is form factor of motherboard? 

Ans:The form factor of a motherboard determines the specifications for its general shape and size. It also 

specifies what type of case and power supply will be supported, the placement of mounting holes, and the 

physical layout and organization of the board.  Form factor is especially important if you build your own 

computer systems and need to ensure that you purchase the correct case and components. 

 

42)   What is ATX? How it is different from AT? Which is using now? 

Ans:AT is a short for advanced technology, the AT is an IBM PC model introduced in 1984. It includes 

an Intel 80286 microprocessor, a 1.2MB floppy drive, and an 84-key AT keyboard. The ATX form factor 

specified changes to the motherboard, along with the case and power supply. Some of the design 

http://www.webopedia.com/TERM/D/DRAM.html
http://www.webopedia.com/TERM/P/printed_circuit_board.html
http://www.webopedia.com/TERM/M/memory.html
http://www.webopedia.com/TERM/C/chip.html
http://www.webopedia.com/TERM/M/Macintosh_computer.html
http://www.webopedia.com/TERM/P/PC.html
http://www.webopedia.com/TERM/R/RAM.html
http://www.webopedia.com/TERM/B/byte.html
http://www.webopedia.com/TERM/F/form_factor.html
http://www.webopedia.com/TERM/P/power_supply.html
http://www.webopedia.com/TERM/I/IBM_PC.html
http://www.webopedia.com/TERM/I/Intel_microprocessors.html
http://www.webopedia.com/TERM/F/floppy_drive.html
http://www.webopedia.com/TERM/K/key.html
http://www.webopedia.com/TERM/A/AT_keyboard.html
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specification improvements of the ATX form factor included a single 20-pin connector for the power 

supply, a power supply to blow air into the case instead of out for better air flow, less overlap between the 

motherboard and drive bays, and integrated I/O Port connectors soldered directly onto the motherboard. 

The ATX form factor was an overall better design for upgrading. 

 

43) What is the need of expansion slot in motherboard? 

Ans:Alternatively referred to as an expansion port, an expansion slot is a slot located inside a computer on 

the motherboard or riser board that allows additional boards to be connected to it. 

 

44) What is PCI slot? How is different from PCI Express (PCI-E)? 

Ans:Short for PERIPHERAL COMPONENT INTERCONNECT, a local bus standard developed by Intel 

Corporation. PCI Express (Peripheral Component Interconnect Express), officially abbreviated as PCIe, is 

a computer expansion card standard designed to replace the older PCI, PCI-X, and AGP bus standards. 

 

45) What is AGP slot? What is its use? 

The Accelerated Graphics Port (often shortened to AGP) is a high-speed point-to-point channel for 

attaching a video card to a computer's motherboard, primarily to assist in the acceleration of 3D computer 

graphics. Since 2004 AGP has been progressively phased out in favor of PCI Express (PCIe). 

 

46) What is jumper? What is the need? 

A metal bridge that closes an electrical circuit. Typically, a jumper consists of a plastic plug that fits over a 

pair of protruding pins. Jumpers are sometimes used toconfigure expansion boards. By placing a jumper 

plug over a different set of pins, you can change a board's parameters. 

 

47) What CMOS and CMOS battery? 

Short for complementary metal oxide semiconductor. Pronounced see-moss. The CMOS chip holds the 

date, time, and system setup parameters. This chip is powered by a 3Volt  CMOS battery. 

 

48) What is chipset? 

A number of integrated circuits designed to perform one or more related functions. This is one of the 

processing device in a computer. 

 

49) What is power supply unit? 

A power supply unit (PSU) supplies direct current (DC) power to the other components in a computer. It 

converts general-purpose alternating current (AC) electric power from the mains  to low-voltage (for a 

desktop computer: 12 V, 5 V, 5VSB, 3V3, −5 V, and −12 V) DC power for the internal components of the 

computer. 

 

50) What are the different types of Form Factors of Power Supply? 

AT , ATX, Flex ATX, Micro ATX etc… 
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PROBLEM 3: 

Every student should individually install operating system like Linux or MS windows on the personal 

computer. The system should be configured as dual boot with both windows and Linux. 

INSTALLATION OF WINDOWS XP:  

AIM: To install Windows XP 

Hardware Requirements: Personal Computer, XP CD 

Software Requirements: Operating System 

THEORY:   

WINDOWS XP Wide Interactive Network for Development of Office Work Solutions- Experience  

Microsoft Windows XP was introduced in 2001 and is the most significant upgrade to the Windows operating system 

since Windows 95. 

PROCEDURE: 

 Step 1 - Start your PC and place your Windows XP CD in your CD/DVD-ROM drive.  

 
Step 2 – Your PC should automatically detect the CD and you will get a message saying "Press any key to boot from 

CD". Soon as computer starts booting from the CD your will get the following screen: 

 

http://www.techterms.com/definition/operatingsystem
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Step 3 - You will then get a Windows XP Professional Setup screen. You have the following options: 

i) To set up Windows XP now, press Enter 

ii) To repair a Windows Xp Installation, press R 

iii) To quit set up without installing windows XP, press F3. 

 

Step 4 - You will be presented with the End User Licensing Agreement. Press F8 to accept and continue 

 

Step 5 – You will get Windows XP Professional Setup screen and having the following options: 

i) To set up windows XP on selected item, press Enter 

ii) To create a partition in the unpartitioned space, press C 

iii) To delete the selected item , press D 

When you are doing new partition in hard disk press C to create partition in unpartitioned space 

and give required size for the drive and press Enter. 
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Step 6 – After completion of creating partitions Select Partition 1 (C: Drive) to install operating system on C 

Drive and press Enter. 

 

Step 7 - Choose format of the partition using NTFS/FAT file system. NTFS is the recommended file system 

with Quick option. If the hard drive has been formatted before then you can choose quick NTFS format. We 

chose NTFS because it offers many security features, supports larger drive size, and bigger size files. 

NTFS:  

i) New/Network Technology File System 

ii) It supports larger drive size, bigger size files 

iii) It is more faster to allocate the memory, accessing the data 

iv) Provides more security features. 

v) Provides more Networking options 

vi) Partition size can be of 2 TB or more and file size can be 16 GB  

FAT:  

i) File Allocation Table File System 

ii) It supports low drive size, lesser size files 

iii) It is more slower to allocate the memory, accessing the data 

iv) Provides less security features. 

v) Provides less Networking options 

vi) Partition size can be of 2 TB or more and file size can be 4 GB  
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Step 8 - Windows will now start formatting drive C: and start copying setup files from CD to C Drive. 

 

Step 9 - After the setup has completed copying the files the computer will restart. Leave the XP CD in the 

drive but this time DO NOT press any key when the message "Press any key to boot from CD" is displayed. 

In few seconds setup will continue. Windows XP Setup wizard will guide you through the setup process of 

gathering information about your computer. 

 

Step 10 - Choose your region and language. 

 



35 
ITWORKSHOP LAB MANUAL  

Step 11: Enter your product key. XP Product Key has 25 Characters. 

 

Step 12 - Name the computer, and enter an Administrator password. Don't forget to write down your 

Administrator password. 

 

Step 13 - Enter the correct date, time and choose your time zone. 
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Step 14 - For the network setting choose typical and press next. 

 

Step 15 - Wait for the installation to finalize. This will only take a few minutes, and the computer will 

reboot when it is finished installing 

 

Step 16 - Set your display preferences. Once Windows loads, you will be told that Windows will 

automatically configure your display. Click OK to start the configuration. Your screen will flash a couple 

times, and then you will be asked if you can read the box that appears. 
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Step 17 - Set your connection preferences. If your computer is connected to the internet, select your 

connection type. Press Next to continue. 

 

Step 18 - Activate your copy of Windows. If connected to the Internet, Select "Activate Now." Windows 

will connect to the activation server and automatically authenticate your copy of Windows. If you haven’t 

entered your Product Key yet, you will need to enter it now. 

 

Step 19 - Add users that will sign on to this computer and click next. 
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Step 20: Log in, to your PC for the first time. 

 

 

Test Data: No Test Data for this Experiment 

Errors: No Errors for this for this Experiment 

Result: Installing the Windows XP operating system on a pc is completed 

 

 

. 

ii). AIM: To install Linux in system 

Software Requirement: Linux compact discs (3) 

Hardware Requirement: Personal Computer 

THEORY:  Linux is a Unix-like operating system that was designed to provide personal computer users a free or 

very low-cost operating system comparable to traditional and usually more expensive Unix systems. Linux has a 

reputation as a very efficient and fast-performing system. Linux's kernel (the central part of the operating system) was 

developed by “Linus Torvalds” at the University of Helsinki in Finland. To complete the operating system, Torvalds 

and other team members made use of system components developed by members of the Free Software Foundation for 

the GNU Project. 

http://searchenterpriselinux.techtarget.com/sDefinition/0,,sid39_gci213253,00.html
http://searchcio-midmarket.techtarget.com/sDefinition/0,,sid183_gci212714,00.html
http://searchenterpriselinux.techtarget.com/sDefinition/0,,sid39_gci212439,00.html
http://searchenterpriselinux.techtarget.com/sDefinition/0,,sid39_gci878891,00.html
http://searchenterpriselinux.techtarget.com/sDefinition/0,,sid39_gci212158,00.html


39 
ITWORKSHOP LAB MANUAL  

PROCEDURE: 

1. Language Selection 

 Using your mouse select the language you would prefer to use for the installation 

 Click next to continue. 

2. Key Board Configuration: 

 Using your mouse select the correct layout type for the keyboard you would prefer to use for the installation 

and as the system default. 

 Once you have made the selection click next to continue. 

 

3. Mouse Configuration: 

 If you have a PS/2, USB or Bus mouse you do not need to pick a port and device. If you have a serial mouse, 

you should choose the correct port and device that your serial mouse is on. 

 The Emulate 3 buttons checkbox allows you to use a two-button mouse as if it had three buttons. If you 

select this check box you can emulate a third “middle” button by pressing both mouse buttons simultaneously. 

4. Installation Type: 

 Choose the type of installation you would like to perform.  

 Your options are Personal desktop, Workstation, Server, Custom and upgrade 

 

5. Disk partition Setup: 

 You can chose automatic partitioning or manual partitioning using Disk Druid of fdisk. 

 Automatic partitioning allows you to perform an installation without having to partition your drives yourself. 

 Automatic partitioning allows you to have some control concerning what  data  is removed from your system. 

 Your options are: 

 Remove all Linux partitions on this system. 

 Remove all partitions on this system 

 Keep all partitions and use existing free space. 

 To partition manually choose either Disk druid or fdisk partitioning tool.   

 Lick next once you have made your selections. 

5. Partitioning your system: 

 If you chose automatic partitioning and did not select Review skip ahead 

 If you choose automatic partitioning and selected review you can either accept the current 

partition settings (click next) or modify the setup using Disk Druid, the manual partition tool. 

 If you choose manual partition with fdisk skip ahead. 
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 At this point you must tell the installation program where to install Linux. This is done by 

defining mount points for one or more disk partitions in which Linux will be installed. 

6. Adding Partitions: 

 To add a new partition select new button, a dialogue box appears. 

 Select the options and click ok 

7. Boot Loader Configuration: 

 Boot loader is the first software program that runs when a computer starts. 

 The installation program provides two boot loaders GRUB ( GR and Unified Boot Loader)  which is the 

default and LILO 

  If you do not want GRUB as your boot loader click Change Boot Loader. 

 You can then choose to install LILO or choose not to install boot loader at all by clicking  Do not install boot 

loader  on the  change boot loader  button. 

 Network devices are automatically detected and displayed in Network Devices list, 

 Select a  network device and click Edit 

 Here you can configure IP address and net mask of the device. 

8. Firewall configuration: 

 Offers firewall protection for enhanced protection. 

 A properly configured firewall can greatly increase the security of the system. 

9. Time zone configuration: 

You can set your time zone by selecting your computers physical location or by specifying your time zones offset 

from Universal Time. 

10. Account Configuration: 

 Allows to set Root password or user accounts 

 Root count is similar to the administrator password that you set up in Win NT. 

 Click add button to add a new non-rot user. 

 Enter the details and click OK. 

11. Packing group selection: 

You can select package groups which groups components together or individual packages or a combination of the two. 
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LINUX Commands: 

1. ls             by this command we can see only file name nothing else    

syntax 

$ls 

2.clear         it will clear the screen(short cut ctl+l)    

syntax 

$clear 

3.exit to end a current session as well current terminal logging    

syntax 

$exit 

4.touch to create a new empty file     

syntax 

$touch  

5.cd to change the working/present directory        

syntax 

$cd /home/mango 

    where '/home/mango' is the desired directory to be change from '/root' 

6.cat to view the contents of a file and it is also used for creating a new file with some contents 

Syntax 

$cat <file name>       to view file contents 

$cat > newfilename     enter,then you can write something in the file and then to save the file contents press clt+d then 

enter 

7.mkdir     to make a new directory  

syntax  

$mkdir newdirname 

    you can also create a directory at your desired path without changing your present working directory 
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syntax 

$mkdir /home/mango/newdirname 

8.rm       to remove a empty file     

syntax 

$rm filename  

9.rmdir       to remove a empty directory 

syntax 

$rmdir directoryname 

10.rm     [-i/-r/-f] to remove a directory with its subdirectories as well as its files that is to remove a directory which 

already contains some files in it 

syntax 

$rm -i directory/filename 

    -i  stands for interactively 

                 -r  stands for recursively 

                 -f  stands for forcefully 

11.cp     to copy something in a destination file or directory    

syntax 

$cp sourcepath destinationpath 

example: $cp /home/mango/webmin.rpm /root/abcd 

                  in this example the webmin.rpm file will be copied in /root/abcd directory 

12.mv      to move one file or directory from one place to another place, it    

is also used for renaming adirectory or file 

syntax 

$mv source destination 

$mv oldfilename newfilename     [to change the file name] 

13.man      to view the 54anual page of commands for syntax    
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syntax 

$man commandname 

14.info       to view the information about any command    

syntax 

$mkdir info 

15.--help     to view the help 55ocuments of a command  

syntax  

$commandname –help 

16.who     by this command you can see the user name and their ip addresses who have loged in on your server 

Syntax      $who 

 

17.whoami      this command shows your current logged in terminal user name 

syntax 

$whoami 

Standard directory structure 

◮ / - the topmost 

◮ /dev - all the devices are accessible as files 

◮ /var - “variable” data such as mails, log files, databases 

◮ /usr - almost all the packages installed 

◮ /etc - configuration files 

◮ /home - home directories for all the users 

◮ /root - home directory of the privileged user root 

◮ /mnt - used to mount other directories/partitions 

 

Test Data: No Test Data for this Experiment 

Errors: No Errors for this for this Experiment 
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Result: Installing the LINUX operating system on a pc is completed 

Viva Questions: 

Viva Questions: 

1) Explain the main purpose of an operating system? 

Ans:Operating systems exist for two main purposes. One is that it is designed to make sure a computer 

system performs well by managing its computational activities. Another is that it provides an environment 

for the development and execution of programs 

 

      2) Which is the file system of a floppy disk? 

FAT. 

 

3) In Windows XP, what does the letter XP stand for? 

The letters XP actually stands for eXPerience. It was designed as an enhancement of Windows 2000, with a 

totally different and more attractive user interface/console. 

4) What is a Hotfix? 

Hotfix are files that are distributed by Microsoft Customer Service. These are intended to address issues 

such as bugs and errors within existing software. 

5) What is NTFS? 

NTFS is short for New Technology File System. It is the standard file system that is being used by operating 

systems starting from Windows NT, Windows 2000, Windows XP, and even the newer versions like Vista 

and 7. It was originally designed to have a better performance on file storage and retrieval under the 

Windows NT family. 

6) What are DLLs? 

DLL is short for Dynamic Link Library. These are shared library files that contain usable codes and routines 

that other applications can utilize to create other new applications. 

7) Which Microsoft Certification is considered the most popular? 

It is the Microsoft Certified Systems Engineer (MCSE). This certification deals with skills related to 

applying solutions to business productivity by utilizing Microsoft Server operating system. 

8) What is registry? 

Registry is a very important component of the Windows Operating System. It stores  important information, 

such as setup and configuration, installation settings, and user settings. 

9) What is ScanDisk and what does it do? 
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ScanDisk is a diagnostic tool that checks a hard drive for errors, file corruptions and data integrity. It can do 

repairs on errors that it detects. 

10) How do you reverse a doubly-linked list? 

To do this, start from the head and traverse to the end. For each node in the list that was traversed, swap the 

values of the links “Next” and “Prev”. After that, set the “Head” to link to the last node or tail. 

11) Give some known Windows version and its codename 

Windows 98 – Memphis 

Windows Me – Millenium 

Windows XP – Whistler 

Windows Vista – Longhorn 

Windows 7 – Vienna and Blackcomb 

12) What are cookies? 

Cookies are small pieces of information that are stored in a browser. It keeps track of user preference, like 

what sites are visited, what keywords are used, among others. 

13) What File system is supported by Windows XP? 

Windows XP supports four major file systems: FAT12, FAT16, FAT32 and NTFS. This means that 

Windows XP can be installed on these file systems. The use of NTFS is preferred especially when using a 

bigger hard drive space. 

14) What is the purpose of a Service Pack? 

A Service Pack combines hotfixes and updates into one installer module. These are mainly used to upgrade 

an existing software version without the need to uninstall and reinstall an entire software package. 

15) What is the purpose of Option Explicit? 

Option Explicit ensures that all variables to be used in a program are defined or declared, therefore 

specifying what data type it is intended for. 

16) Differentiate linked list from arrays. 

Arrays can store data in a fix allotted space. The use of linked list allows more flexibility because space is 

dynamically allocated as needed. 

17) What is defrag? 

Defrag is a system utility tool under Windows operating system that is designed to rearrange the ordering of 

data on disk. This action makes the disk run faster and access to data more efficient. 

18) What is the difference between a Windows server operating system and a workstation version? 
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The server version of a Windows operating system is designed to provide more optimized networking 

services over a network. It can manage domains better and it includes more security feature and data backup 

support. Workstation versions act merely as clients and therefore do not need to have as much resources 

when compared to the server versions. 

19) What is the purpose of creating partitions for a Windows operating system? 

Creating partition may serve different purposes. The common reason is that a separate partition can be used 

to store data files so that when Windows needs to be reinstalled, the main partition can be formatted without 

fear of loosing data, which are stored on the other partition. 

20) How do you correctly arrange the order by which pressing the tab key will move from one control 

object to another? 

You do that by setting the tabIndex property. Click on one control object to another in the sequence that you 

want, and then each time you set the tabIndex property of each object as 0. That will automatically arrange 

according to the sequence that you want. 

21) What is a Process  

a program in execution 

22) What is Linux? 

Linux is an operating system based on UNIX, and was first introduced by Linus Torvalds. It is based on the 

Linux Kernel, and can run on different hardware platforms manufactured by Intel, MIPS, HP, IBM, SPARC 

and Motorola. Another popular element in Linux is its mascot, a penguin figure named Tux. 

23) What is the difference between UNIX and LINUX? 

Unix originally began as a propriety operating system from Bell Laboratories, which later on spawned into 

different commercial versions. On the other hand, Linux is free, open source and intended as a non-propriety 

operating system for the masses. 

24) What is BASH? 

BASH is short for Bourne Again SHell. It was written by Steve Bourne as a replacement to the original 

Bourne Shell (represented by /bin/sh). It combines all the features from the original version of Bourne Shell, 

plus additional functions to make it easier and more convenient to use. It has since been adapted as the 

default shell for most systems running Linux. 

25) What is Linux Kernel? 

The Linux Kernel is a low-level systems software whose main role is to manage hardware resources for the 

user. It is also used to provide an interface for user-level interaction. 

26) What is LILO? 

LILO is a boot loader for Linux. It is used mainly to load the Linux operating system into main memory so 

that it can begin its operations. 

27) What is a swap space? 
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A swap space is a certain amount of space used by Linux to temporarily hold some programs that are 

running concurrently. This happens when RAM does not have enough memory to hold all programs that are 

executing. 

      28) What is the advantage of open source? 

Open source allows you to distribute your software, including source codes freely to anyone who is 

interested. People would then be able to add features and even debug and correct errors that are in the source 

code. They can even make it run better, and then redistribute these enhanced source code freely again. This 

eventually benefits everyone in the community. 

29) What are the basic components of Linux? 

Just like any other typical operating system, Linux has all of these components: kernel, shells and GUIs, 

system utilities, and application program. What makes Linux advantageous over other operating system is 

that every aspect comes with additional features and all codes for these are downloadable for free. 

30) Does it help for a Linux system to have multiple desktop environments installed? 

In general, one desktop environment, like KDE or Gnome, is good enough to operate without issues. It’s all 

a matter of preference for the user, although the system allows switching from one environment to another. 

Some programs will work on one environment and not work on the other, so it could also be considered a 

factor in selecting which environment to use. 

31) What is the basic difference between BASH and DOS? 

The key differences between the BASH and DOS console lies in 3 areas: 

– BASH commands are case sensitive while DOS commands are not; 

– under BASH, / character is a directory separator and \ acts as an escape character. Under DOS, / serves as 

a command argument delimiter and \ is the directory separator 

– DOS follows a convention in naming files, which is 8 character file name followed by a dot and 3 

character for the extension. BASH follows no such convention. 

32) What is the importance of the GNU project? 

This so-called Free software movement allows several advantages, such as the freedom to run programs for 

any purpose and freedom to study and modify a program to your needs. It also allows you to redistribute 

copies of a software to other people, as well as freedom to improve software and have it released to the 

public. 

33) Describe the root account. 

The root account is like a systems administrator account, and allows you full control of the system. Here you 

can create and maintain user accounts, assigning different permissions for each account. It is the default 

account every time you install Linux. 

34) What is CLI? 

CLI is short for Command Line Interface. This interface allows user to type declarative commands to 

instruct the computer to perform operations. CLI offers an advantage in that there is greater flexibility. 

However, other users who are already accustom with using GUI find it difficult to remember commands 

including attributes that come with it. 

35) What is GUI? 

GUI, or Graphical User Interface, makes use of images and icons that users click and manipulate as a way of 

communicating with the computer. Instead of having to remember and type commands, the use of graphical 
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elements makes it easier to interact with the system, as well as adding more attraction through images, icons 

and colors. 

36) How do you open a command prompt when issuing a command? 

To open the default shell (which is where the command prompt can be found), press Ctrl-Alt-F1. This will 

provide a command line interface (CLI) from which you can run commands as needed. 

37) How can you find out how much memory Linux is using? 

From a command shell, use the “concatenate” command: cat /proc/meminfo for memory usage information. 

You should see a line starting something like: Mem: 64655360, etc. This is the total memory Linux thinks it 

has available to use. 

38) What is typical size for a swap partition under a Linux system? 

The preferred size for a swap partition is twice the amount of physical memory available on the system. If 

this is not possible, then the minimum size should be the same as the amount of memory installed. 

39) What are symbolic links? 

Symbolic links act similarly to shortcuts in Windows. Such links point to programs, files or directories. It 

also allows you instant access to it without having to go directly to the entire pathname. 

40) Does the Ctrl+Alt+Del key combination work on Linux? 

Yes, it does. Just like Windows, you can use this key combination to perform a system restart. One 

difference is that you won’t be getting any confirmation message and therefore, reboot is immediate. 

41) Which tool can you use to prepare a USB device so that you can boot from it to install Windows 7 

on a netbook? 

Diskpart 

42). Which of the following versions and editions of Windows 7 can you install to take advantage of 

the hardware resources on a computer that has 16 GB of RAM? (Choose all that apply.) 

Windows 7 Home Premium x64 

43. Windows 7 comes in several different versions such as Home, Professional and Ultimate. You can 

also run Windows 7 in 32 or 64 bit versions. If you want to install and run a 64 bit version of Windows 

7 which one of the following is NOT a requirement? 

At least 4GB of ram 

44). Windows 7 comes in a variety of versions including Home, Professional and Ultimate. Which 

version of Windows 7 comes with a form of encryption designed to help protect data on your PC and 

portable storage devices against loss or theft? 

Ultimate x64 

45. Windows 7 comes in both a 32 bit and 64 bit versions. What is the minimum processor speed 

recommended by Microsoft for running the 64 bit version of Windows 7? 

1 GHz 
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46)Which version of Windows 7 comes with Windows Touch built in? 

Home Premium, Professional and Ultimate 

 

47). What is the minimum number of volumes that a computer running Vista should have if you want 

to support dual-booting with Windows 7? 

2 

48). In which of the following scenarios must you perform a migration rather than an upgrade? 

Windows XP Pro (x64) to Windows 7 Pro (x64) 

49). You are using sysprep to prepare a system for imaging. You want to reset the security ID (SID) 

and clear the event logs. Which option should you use? 

/generalize 

50). You want to create a 30GB native VHD called MySystem.vhd in a folder called Windows 7 on an 

external USB hard disk with the drive designation H. Which command do you use? 

Create vdisk file=h:\windows7\mysystem.vhd maximum=30000 
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PROBLEM 5: 

Hardware Troubleshooting: Students have to be given a PC which does not boot due to improper assembly or 

defective peripherals. They should identify the problem and fix it to get the computer to working back condition. 

AIM: Hardware troubleshooting 

Hardware Requirements: Personal Computer 

Software Requirements: Operating System 

THEORY: 

If your PC hangs up or freezes it may be due to the hardware/software conflicts, faulty processor fan, inadequate 

RAM and a virus/spyware attack.  To deal with the security related threats such as viruses, hacking attacks, spyware, 

adware, Trojan horses, browser hijacks and other, you need to install up-to-dated antivirus, anti spyware software and 

properly configured firewall software or hardware. This article will provide you help in troubleshooting the most 

common problems with your PC. 

Hard Disk Problems 

If you hard disk does not spin up then you need to do the following. 

Check the power connectors are properly connected. 

Check if the IDE ribbon cable is properly connected with the motherboard and hard disk. 

If the problem still not resolved then there may be bad sectors or other physical defects in your hard disk.  Use a hard 

disk diagnostic utility, it will diagnose the health status of your hard disk and will help you to troubleshoot the 

common problems. 

Printer Problems 

If your printer does not print, then you need to do the following. 

Check the cables. 

Restart the printer. 

Update the driver. 

Check the alignment of the printer. 

If the problem is still not resolved then you need to reinstall the printer. 

Memory Problems 
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Sometimes bad or low memory leads to system crash, slow response time and the system freeze.  To troubleshoot the 

memory related problems in your system you need to do the following. 

Check the memory sticks. 

Replace the memory modules. 

 

Increase the amount of memory in your system.  It will fix a number of system errors that are caused due to the low 

memory. 

Motherboard Problems 

A PC motherboard consists of an I/O ports, expansion slots, input device ports, RAM memory and CPU socket.  A 

misconfigured motherboard may results in the system errors or no display at all. To troubleshoot the errors with your 

system’s motherboard you need to do the following.  

Double check the motherboard’s jumper settings 

Upgrade the drivers of the newly installed motherboard and set the BIOS according to the manufacturer’s manual. 

Remove all the optional devices and see if the problem is solved or not. 

Double check all the connections to the motherboard. 

Check the system’s BIOS and see if it is properly configured or not. 

Make sure that the keyboard and mouse are properly inserted into the motherboard. 

     Computer error beeps codes: 

No beep: short, no power, bad CPU/ MD, loose peripherals. 

One beep: everything is normal & computer posted tax. 

Two beeps: post / CMOS error. 

One long beep One short beep: Motherboard problem. 

One long beep two short beep: video problem. 

One long beep 3 short beeps: video problem. 

3 long beeps: keyboard error. 

Repeated long beep:  memory error. 

Continuous high- low beeps: CPU overheating  
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Test Data: No Test Data for this Experiment 

Errors: No Errors for this for this Experiment 

Result: Hardware Troubleshooting is completed on a system 

Viva Questions: 

1. Which of the following would you use to keep the power supply working properly?  

To keep your power supply up and running and to help prevent damage from power surges, you should use 

a surge protector. The UPS will supply power for a short period of time to the computer system in case of 

total power outage. 

2. Power supplies are rated using which of the following units?  

Power supplies are rated in watts, and the more watts a power supply provides, the more devices it can 

safely power 

3. Newer tower-case computers’ power supplies typically have which of the following power output 

ratings?  

Most newer tower computers have 500 watt or larger power supplies in them because of the greater number 

of drives and expansion cards that are available now 

 4. Most power supplies in use today are designed to handle which two voltage ranges?  

Standard North American power is 115 volts, and power in most parts of Europe and Asia is 230 volts. 

Some power supplies have a slider on the back to switch between the two voltages. 

5. Which of the following are causes of power supply overheating?  

All of the listed reasons can cause damage to the power supply as well as overheating your computer. 

6. How many pins are used for the main power connection by recent ATX/BTX motherboards with 

ATX12V 2.2 power supplies?  

Most of the newer power supplies in use today have 24 pins. Older motherboards have a 20-pin connection. 

7. What is the four-pin square power connector on the motherboard used for 

This connector is the ATX12V connector, which provides 12V power dedicated to the processor (a voltage 

regulator on the motherboard reduces 12V to the actual power required by the processor). 

 8. What is the six-pin power lead on the power supply used for?  

The six-pin (or 6+2 pin) power supply lead provides additional power needed by high-performance PCIe 

x16 cards, such as those used for SLI or for CrossFire X multi-GPU installations 

9. Which of the following steps would you use to remove a power supply? 

You must disconnect from the wall first; then once inside the computer unhook the connection to the 

motherboard, drives, and other devices 

 10. To avoid power supply hazards you must never do which of the following 

 The capacitors inside the power supply retain potentially fatal voltage levels. To prevent shock you should not 

disassemble power supplies or stick in a metal object such as a screwdriver. 
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  11. Which device provides emergency power to a computer in case of a complete power failure? 

  A UPS (uninterruptible power supply) will keep a standard desktop up and running in case of a complete power   

    outage.  

 

    12. What is the minimum time recommendation for a UPS to supply power for an individual 

     workstation? 

    UPSs are designed to supply power to a computer long enough for you to complete a formal shutdown 

 

   13. Which of the following correctly describe an SPS? (Choose all that apply.)  

   When an SPS is used there is a momentary gap, usually about 1ms or less, between when the power goes off and 

when the SPS starts supplying power. SPSs are also less expensive and are not used at all times. 

 

   14. When a system is dead and gives no signs of life when you turn on the computer, which of the 

following might be the cause? 

  When turning on a system that shows no signs of life you must consider all of these as potential problems. 

 

  15. Processors and other components use a finned metal device to help with cooling. What is this 

device called?  

All processors require a heat sink. A heat sink is a finned metal device that radiates heat away from the processor. An 

active heat sink (a heat sink with a fan) is required for adequate processor cooling on current systems. Some older 

systems used a specially designed duct to direct airflow over a processor with a passive heat sink (a heat sink without 

a fan). Most motherboards’ northbridges use passive heat sinks or heat pipes. 

 

  16. What is the purpose of thermal compound 

      Thermal compound (also known as thermal transfer material, thermal grease, or phase change material) provides 

for the best possible thermal transfer between a component (for example a CPU) and its heat sink. This prevents CPU 

damage. The fan and adapter cards should not have thermal compound applied to them. 

 

17 Define Trouble Shooting? 
Ans:  Trouble shooting is the procedure to solve the problems and giving the solutions to them. 

 

18. If the Picture of the Monitor is not visible, give the solution? 

Ans: Check the power connections on both sides of cabinet and monitor, check the Brightness control.  

 

19 What is most commonly used game port? 

Ans:Joystick, Games Paddle, Keyboard, Mouse. 

 

20 What is the full form of MIDI? 

Ans: Musical Instrumental Digital Interface. 
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PROBLEM 6: 

Students have to be given a malfunctioning CPU due to system software problems. They should identify the 

problem and fix it to get the computer back to working condition. The work done should be verified by the 

instructor and followed up by the viva. 

AIM: Software troubleshooting 

Hardware Requirements: Personal Computer 

Software Requirements: Operating System 

PROCEDURE: 

Error messages encountered during boot before Windows loads 

 Ensure that your computer BIOS settings are correctly configured to the hardware that is installed in your 

computer 

Error messages while windows loading 

1. If you have recently installed or changed something that could have caused normal windows to stop loading, try 

loading the last known good configuration 

2. If you are unable to get into Normal windows and believe that removing or uninstalling a program or changing a 

setting may help enable you to get into windows, boot the computer into windows XP safe mode 

3. If your computer has worked fine in the past but recently   has been experiencing the issue you are encountering run 

the system restore option to restore the computer to an earlier date 

Other error messages that occur while windows is loading or after windows is loaded 

1. If error occurs but windows still loads, verify no issues or conflict exits in device manager  

2. Ensure that if programs are loading automatically that these errors are not associated with these programs 

3. Make sure Windows XP is up to date by checking Microsoft windows update page 

4. If your computer has virus protection installed make sure that it is up to date and that no virus are being detected 

5. If your computer has worked fine in the past but recently   has been experiencing the issue you are encountering run 

the system restore option to restore the computer to an earlier date 

REINSTALL: When a particular program is not working, reinstalling the failing application may be the fix you 

need.  Save any settings and data used by the program, and then use the original install disks to recopy the program 

components to your hard drive.   
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ELIMINATE TROUBLESOME PROGRAMS: If you notice that consistent problems began when you installed an 

unnecessary program, then uninstall that program from your system (click on START -> SETTINGS -> CONTROL 

PANEL -> ADD/REMOVE PROGRAMS). 

REINSTALL/UPDATE DRIVERS:  Many hardware associated problems are caused by driver conflicts, corrupt 

driver components, and drivers which need to be updated for use with new program releases.  When a piece of 

hardware stops working or continually produces errors, try reinstalling the driver disk that came with it. 

DEFRAG THE HARD DRIVE:  After a computer has been used for a while, data and software components tend to 

get scattered around the surface of the hard drive.  This can lead to cross linked files, problems with software, and 

reduced system performance.  Running a “defrag” takes each of these scattered bits of information and lines them up 

neatly in concentric circles on the hard drive. Your system will perform faster after defragmentation, and certain types 

of software problems will be eliminated.  To run the built in Windows defrag program, click on START -> 

PROGRAMS -> ACCESSORIES - SYSTEM TOOLS -> DISK DEFRAGMENTER.   

REINSTALL THE OS:  Reinstalling your Windows operating system is one of the best cures to an enormous 

number of common computer problems.   

Test Data: No Test Data for this Experiment 

Errors: No Errors for this for this Experiment 

Result: Software Troubleshooting is completed on system software 

Viva Questions: 

1. What are the Common Software problems and solutions 

There are numerous computer software issues that are elementary to fix, but hard to diagnose. When you 

successfully identify the appropriate problem, it becomes easy to iron out the pitfall. Now, let’s share the 

common software problems and solutions according to experience. 

1. Viruses 2.Malware 3.Spyware 

2. What  isVirus  

It is a very generic problem with your computer. Your computer gets this problem by merely visiting a 

website. Some of the symptoms of PC viruses are strange behavior in the OS, non-responsive applications 

and slow performance. 

However, do not get scared because the solution to this problem is not hard. You can install antivirus 

program in your computer to get rid of this problem 

. 

3. What is Malware 
It is another generic problem that infects your computer. Malware means malicious software. Worms and 

Trojan Horses are some of the examples of common malware. Malware often enters your computer via mail 

attachments.It is really difficult to free your computer from malware. It is always suggested that you do a 

system restore and reinstall your operating system. You can go for program such as Malwarebytes Anti-

Malware for less powerful malware. 

4.Spyware 
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It is the most generic computer problem. Your computer can pick spyware from just about anything. 

Slowdown of computer is a symptom of spyware. You may also notice some certain programs that you have 

never installed in your computer. 

But the good thing is that you can find numerous programs in the market that can remove spyware, some of 

them are free as well. 

5. What are the measures should be taken when system slows down 
If your computer doesn’t have any of the aforementioned problems, but still it is performing slowly, you 

need to do some couple of actions to fix the problem. 

Just execute a disk cleanup: “Start > All Programs > Accessories > System Tools > Disk Cleanup.” 

Defragment your hard drive: “Start > All Programs > Accessories > System Tools > Disk Defragmenter.” 

6. What should be done when some file is missing error occurred ? 
The System File Checker (SFC) tool enables you to scan for – and replace – corrupt and missing fi les. If you use XP 
you can use it to scan your entire drive, while in Vista and Windows 7 it can verify individual fi les and folders too. If 

you have an installation CD, keep it handy in case it's needed. 

                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                            

7. PC keeps rebooting after Windows Update 

 

If your PC gets stuck in a cycle of rebooting during the update process, you need to undo the updates using System 
Restore. If your computer came without a Windows disc, look for an option to access recovery options, or tap [F8] 

before Windows starts loading, and then choose "Repair your computer". 

If you have an installation disc, boot from it, select your language and then choose "Repair your computer". In both 

cases, when the menu appears, choose System Restore to undo the update. 

8. What is antivirus software? 

Ans: Anti virus Software is a program that installed on your computer, it helps to protect computer against most 

viruses, worms,Trojan Horses. 

9. Define worm? 

Ans:Worms are self replicating viruses that reside in the active memory of computer. 

`10. What are the advantages of antivirus software? 

By using Anti virus  Software you  can keep your computer healthy and protects from malicious act. 

11.What are the types of antivirus software’s available? 

Ans: Avast, Antivira, Kaspersky, Quickheal, Symantec , AVG,  

12. What is Torjan Horse? 

A destructive program that masquerades as a benign application. Unlike viruses, Trojan horses do not 

replicate themselves but they can be just as destructive. One of the most insidious types of Trojan horse is a 

program that claims to rid your computer of viruses but instead introduces viruses onto your computer. 

13. What are networks Worms? 
Network worms can exploit network configuration errors (for example, to copy themselves onto a fully accessible 

disk) or exploit loopholes in operating system and application security. Many worms will use more than one method 

in order to spread copies via networks. 

http://www.webopedia.com/TERM/P/program.htm
http://www.webopedia.com/TERM/A/application.html
http://www.webopedia.com/TERM/V/virus.htm
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14. What is phishing? 

phishing is a term used to describe a malicious individual or group of individuals who scam users. They do 

so by sending e-mails or creating web pages that are designed to collect an individual's online bank, credit 

card, or other login information. Because these e-mails and web pages look like legitimate companies users 

trust them and enter their personal information. 

15. What is Troubleshooting? 

Trouble shooting is the procedure to solve the problems and giving the solutions to them. 

16. What is software Trouble shooting? 

Is referred to removal of the problems arising due to system software or application software 

17. What is the Defragmentation? 

Defragmenting a computer is a process for cleaning out fragmented files and folders on a hard drive. 

18. Define  Device Drivers? 

Device Driver is a computer program allowing higher-level computer programs to interact with a hardware 

device 

19 What should be done when Error messages encountered during boot before Windows loads 

 Ensure that your computer BIOS settings are correctly configured to the hardware that is installed in your 

computer Error messages while windows loading 

20 What should we do when we are unable to getinto Normally windows? 

If you are unable to get into Normal windows and believe that removing or uninstalling a program or 

changing a setting may help enable you to get into windows , boot the computer into windows XP safe mode  

 

 

 

 

 

 

 

 

 

 

https://www.computerhope.com/jargon/e/email.htm
https://www.computerhope.com/jargon/w/webpage.htm
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PROBLEM 7: 

Orientation & Connectivity Boot Camp:  Students should get connected to their Local Area Network and access the 

Internet. In the process they configure the TCP/IP setting. Finally students should demonstrate, to the instructor, how 

to access the websites and email. If there is no internet connectivity preparations need to be made by the instructors to 

simulate the WWW on the LAN 

AIM: To learn Local Area Network and access the Internet. In the process they configure the TCP/IP setting. Finally 

students should demonstrate, to the instructor, how to access the websites and email  

Hardware Requirements: Personal Computer, LAN Card, LAN cables 

Software Requirements: Operating System 

THEORY: 

The internet is a worldwide, publicly network of interconnected computer networks  

LOCAL AREA NETWORK: 

LANs are privately owned networks within a single building or campus of up to few kilometers in size. 

METROPOLITON AREA NETWORK 

MANs are group of networks which are located in different metropolitan cities, within a city covering different areas.  

WIDE AREA NETWORK: 

A WAN is a network that connects computers across a large geographic area such as a city or country. 

Classes of Networks: 

Class Type Subnet Mask 1
st
 Octet Range No. of Computers 

Class A 255.0.0.0 0-124 256X256X256 

Class B 255.255.0.0 125-198 256X256 

Class C 255.255.255.0 199-225 256 

Class D Reserved for new researches 

TCP/IP (Transmission Control Protocol/Internet Protocol): 

Collection of methods used to connect servers on the internet and to exchange data. 

HTML (Hyper Text Markup Language): 

The coding used to control the look of documents on the web 
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HTTP (Hyper Text Transfer Protocol): 

Part of a URL that identifies the location as one that uses HTML 

IP (Internet Protocol): 

A format for contents and addresses of packets of information sent over the internet 

IP ADDRESS: 

An identifier for a computer or device on a TCP/IP network  

SEARCH ENGINE: 

A program that searches documents located on the Internet for keywords or phrases entered by a person browsing the 

net. 

Internet Connection requirements: 

 TCP/IP protocol 

 Client Software 

 ISP Account 

Means of communication to the net 

 telephone Modem 

 Ethernet 

 ISDN(Integrated Services Digital Network) 

 DSL(Digital Subscriber Line) 

 Satellite. 

PROCUDURE: 

Open Network Connections.  

Click the connection you want to configure, and then, under Network Tasks, click Change settings of this 

connection.  

Do one of the following:  

If the connection is a local area connection, on the General tab, under This connection uses the following items, 

click Internet Protocol (TCP/IP), and then click Properties.  

If this is a dial-up, VPN, or incoming connection, click the Networking tab. In This connection uses the following 

items, click Internet Protocol (TCP/IP), and then click Properties.  

Do one of the following:  
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If you want IP settings to be assigned automatically, click Obtain an IP address automatically, and then click OK.  

If you want to specify an IP address or a DNS server address, do the following:  

Click Use the following IP address, and in IP address, type the IP address.  

Click Use the following DNS server addresses, and in Preferred DNS server and Alternate DNS server, type the 

addresses of the primary and secondary DNS servers.  

To configure DNS, WINS, and IP Settings, click Advanced. 

To make a Local Area Connection 

If you have a network adapter installed, and have set up a home or small office network, you are connected to a local 

area network (LAN). You are also connected to a LAN if your Windows XP Professional computer is part of a 

corporate network. When you start your computer, your network adapter is detected and the local area connection 

automatically starts. Unlike other types of connections, the local area connection is created automatically, and you do 

not have to click the local area connection in order to start it. 

Result: LAN Connectivity Task is completed. 

Viva Questions: 

    1) What is a Link? 

A link refers to the connectivity between two devices. It includes the type of cables and protocols used in 

order for one device to be able to communicate with the other. 

2) What are the layers of the OSI reference model? 

There are 7 OSI layers: Physical Layer, Data Link Layer, Network Layer, Transport Layer, Session Layer, 

Presentation Layer and Application Layer. 

3) What is backbone network? 

A backbone network is a centralized infrastructure that is designed to distribute different routes and data to 

various networks. It also handles management of bandwidth and various channels. 

4) What is a LAN? 

LAN is short for Local Area Network. It refers to the connection between computers and other network 

devices that are located within a small physical location. 

5) What is a node? 

      A node refers to a point or joint where a connection takes place. It can be computer or device that is part 

of a network. Two or more nodes are needed in order to form a network connection. 

6) What are routers? 

Routers can connect two or more network segments. These are intelligent network devices that store 

information in its routing table such as paths, hops and bottlenecks. With this info, they are able to 

determine the best path for data transfer. Routers operate at the OSI Network Layer. 
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7) What is point to point link? 

It refers to a direct connection between two computers on a network. A point to point connection does not 

need any other network devices other than connecting a cable to the NIC cards of both computers. 

8) What is anonymous FTP? 

Anonymous FTP is a way of granting user access to files in public servers. Users that are allowed access to 

data in these servers do not need to identify themselves, but instead log in as an anonymous guest. 

9) What is subnet mask? 

A subnet mask is combined with an IP address in order to identify two parts: the extended network address 

and the host address. Like an IP address, a subnet mask is made up of 32 bits. 

10) What is the maximum length allowed for a UTP cable? 

A single segment of UTP cable has an allowable length of 90 to 100 meters. This limitation can be 

overcome by using repeaters and switches. 

11) What is data encapsulation? 

Data encapsulation is the process of breaking down information into smaller manageable chunks before it is 

transmitted across the network. It is also in this process that the source and destination addresses are 

attached into the headers, along with parity checks. 

12) Describe Network Topology 

Network Topology refers to the layout of a computer network. It shows how devices and cables are 

physically laid out, as well as how they connect to one another. 

13) What is VPN? 

VPN means Virtual Private Network, a technology that allows a secure tunnel to be created across a network 

such as the Internet. For example, VPNs allow you to establish a secure dial-up connection to a remote 

server. 

14) Briefly describe NAT. 

NAT is Network Address Translation. This is a protocol that provides a way for multiple computers on a 

common network to share single connection to the Internet. 

15) What is the job of the Network Layer under the OSI reference model? 

The Network layer is responsible for data routing, packet switching and control of network congestion. 

Routers operate under this layer. 

16) How does a network topology affect your decision in setting up a network? 

Network topology dictates what media you must use to interconnect devices. It also serves as basis on what 

materials, connector and terminations that is applicable for the setup. 

17) What is RIP? 

RIP, short for Routing Information Protocol is used by routers to send data from one network to another. It 

efficiently manages routing data by broadcasting its routing table to all other routers within the network. It 

determines the network distance in units of hops. 

18) What are different ways of securing a computer network? 



74 
ITWORKSHOP LAB MANUAL  

There are several ways to do this. Install reliable and updated anti-virus program on all computers. Make 

sure firewalls are setup and configured properly. User authentication will also help a lot. All of these 

combined would make a highly secured network. 

19) What is NIC? 

NIC is short for Network Interface Card. This is a peripheral card that is attached to a PC in order to connect 

to a network. Every NIC has its own MAC address that identifies the PC on the network. 

20) What is WAN? 

WAN stands for Wide Area Network. It is an interconnection of computers and devices that are 

geographically dispersed. It connects networks that are located in different regions and countries. 

21)What is MAC address? 

It is the 48 bit hardware address of LAN card. MAC address is usually stored in ROM on the network 

adapter card and it is unique. 

22)What are the perquisites to configure server? 

• LAN card should be connected: 

• Root (partition on which window is installed) should in NTFS 

• Server should be configured with a static IP address 

23)How we will configure ADS? 

Start ==> RUN ==> DCPROMO 

24)How will you test LAN card? 

Ping 127.0.0.1  

If getting reply its fine 

25)What are the difference between DOMAIN and WORKGROUP? 

Workgroup:-  

(i)Every PC is responsible for its security own.  

(ii)No centralize administration  

(iii)Main aim to save hardware recourse  

(iv)Best suite in school, training institute, cyber café  

Domain: -  

(i)Server is responsible for data safety.  

(ii)Centralize administration  
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(iii)Main aim is to secure data  

(iv)Best suite in company environments 

 

26)Which command is used to check the IP address of your system? 

ipconfig 

 

27)Which set wizard will run to do peer to peer networking in XP? 

Small home and office setup wizard 

 

28)Which command is used to check the physical connectivity between two computers? 

Ping 

 

29)What is map drive? 

A special feature that will map network resource to my computer. 

 

30)What is Proxy Server? 

Most large businesses, organizations, and universities these days use a proxy server. This is a server that all 

computers on the local network have to go through before accessing information on the Internet. By using a 

proxy server, an organization can improve the network performance and filter what users connected to the 

network can access. 
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PROBLEM 8: 

Web Browsers, Surfing the Web: Students customize their web browsers with the LAN proxy settings, bookmarks, 

search toolbars and pop up blockers. Also, plug-ins like Macromedia Flash and JRE for applets should be configured 

PURPOSE: To learn to surf the web 

Hardware Requirements: Personal Computer 

Software Requirements: Operating System, Web Browser, Plug-ins 

THEORY: 

 Web browser provides the means to the searching and also helps to download the web content. 

 Web browsers support most of the famous Internet Protocols like HTTP, FTP.  

 Common file formats a browser accepts  are HTML  

 Well known browsers natively support a variety of other formats in addition to HTML such as 

JPEG,PNG,GIF image formats 

 Different web browsers available in the market are: 

 Silver Smith 

 Mosaic 

 Netscape 

 Mozilla 

 Opera 

 Lynx 

 Safari 

Bookmark: 

Each web browser is built-in with the support of Internet Bookmarks which serve as  a named anchor – primarily to 

URLs. The primary purpose of this book mark is to easily catalog and access web pages that the web browser user has 

visited or plans to visit, without having to navigate the web to get there. 

Pop-up Blockers: 

Pop-ups are a form of online advertising on the WWW intended to attract the attention of the users. These pop ups are 

hosted on the web sites which are frequently visited by the netizens. These pop ups are activated when these web sites 

open a new web browser window and there by displaying the advertisements. 

Plug-ins: 

A plug-in is a software component program that interacts with a main application to provide a better integration of the 

media. The basic difference between application programs and plug-ins  is that multimedia files are launched in a 

separate window where as in plug-ins multimedia play in the browser window. 
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Few famous plug-ins are: 

 Apple Quick Time 

 Macromedia flash 

 Microsoft Media Player 

 Adobe Shockwave 

 Sun Microsystems Java Applet 

PROCEDURE: 

LAN Proxy Settings: 

 select  tools menu in  Internet Explorer 

 Select Internet Options 

 Select  Connections 

 You end up in two options 

 Dial-up  and virtual network settings 

 LAN setting 

 The selection at this step is dependent on the kind of connection you are trying to configure. They are: 

 Dial-up modem connection 

 LAN connection 

 DSL or Cable modem 

Result: Web Browsers, surfing the Web task is completed. 

Viva Questions: 

1) Define surfing? 

Ans: Surfing is an analogy to describe ease with which an expert can use the waves of information 

flowing around the Internet to get where he wants.  

2)  Abbreviate HTML,WWW? 

Ans: HTML (Hyper Text Markup Language), WWW (World Wide Web)  

3) What is a bookmark? 

Ans: A bookmark is a saved link to a Web page that has been added to a list of saved links. 

4) Define a plug-in? 

Ans: Plug-in is a set of software components that adds specific abilities to a larger software application. 

5) What are pop-up ads? 

Ans: Pop-ups ads are used extensively in advertising on the Web, though advertising is not the only 

application for pop-up windows. 

6) What are pop-up blockers? 

Ans:  A pop-up blocker (sometimes called a pop-up killer) is a program that prevents pop-ups from 

displaying in a user's Web browser. 

7) What is a web browser? 
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A web browser is a software application for viewing webpages. Microsoft Internet Explorer,  

Mozilla FireFox, Opera, and Apple Safari are the most common web browsers. 

 

8) What is a safer web browser? 

A safer browser has the following characteristics: 

Latest version 

Automatic software patches and upgrades 

Anti-phishing functionality to notify you when you try to access a suspected fake website 

128-bit encryption that protects data during transmission 

 

9) What are HTTP and HTTPS? 

HTTP (HyperText Transfer Protocol) is a protocol used to send data over the internet. HTTPS 

(HyperText Transfer Protocol using Secure Socket Layer) is a protocol that encrypts data to send it 

over the internet more safely. When you enter a URL into a browser, the address will begin with 

either HTTP or HTTPS 

 

10)  What is SSL (Secure Sockets Layer)? 

SSL (Secure Sockets Layer) is a secure communications protocol used by browsers, websites, and 

applications to protect information sent over the internet. SSL protocol uses encryption and 

authentication technologies to make sure only the intended parties can read the information. 

 

11) What is your definition of the term Cross-Site Scripting? What is the potential impact to 

servers and clients? 

Goal of question This question will determine if the applicant is well versed in the terminology used 

in web security. The applicant needs to be able to articulate highly technological topics to a wide 

audience. The second question will help to verify that the applicant fully understands how XSS 

attacks work and the impact to client information. 

 

12) Which is the fastest web browser? 

Microsoft Internet Explorer usually has the fastest startup time on Microsoft Windows machines, 

although this is mostly because the real "price" of starting it up is paid during the booting of your 

Microsoft Windows system,Opera is the fastest browser in terms of placing minimal demands on an 

older computer. Firefox is a very fast descendant of Mozilla, well-tuned for real-world browsing 

experiences, with an interface that speeds up the way you get things done in a web browser by 

offering features like tabbed browsing and a more elegant "find" feature -- another relevant kind of 

speed 

 

13) A website says I have spyware, is it true? 

hose "spyware detected" and similar messages that appear on specific web pages on top of the actual 

content are ads. 

 

14) What is Cross-Site Scripting? 

An attack technique that forces a web site to echo client-supplied data, which execute in a users web 

browser. When a user is Cross-Site Scripted, the attacker will have access to all web browser 

content (cookies, history, application version, etc). XSS attacks do not typically directly target the 

web server or application, but are rather aimed at the client. The web server is merely used as a 

conduit for the XSS data to be presented to the end client. See also "Client-Side Scripting". 
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15) What is hyperlink? 

In computing, a hyperlink (or link) is a reference to a document that the reader can directly follow, 

or that is followed automatically. The reference points to a whole document or to a specific element 

within a document. Hypertext is text with hyperlinks. Such text is usually viewed with a computer. 

A software system for viewing and creating hypertext is a hypertext system. To hyperlink (or 

simply to link) is to create a hyperlink. A user following hyperlinks is said to navigate or browse the 

hypertext. 

 

16) Explain about Opera (web browser)? 

Opera is a web browser and Internet suite developed by the Opera Software company. The browser 

handles common Internet-related tasks such as displaying web sites, sending and receiving e-mail 

messages, managing contacts, chatting on IRC clients, downloading files via BitTorrent, and 

reading Web feeds. Opera is offered free of charge for personal computers and mobile phones. 

 

17) Explain about Safari (web browser)? 

Safari is a web browser developed by Apple. First released as a public beta on January 7, 2003 on 

the company's Mac OS X operating system, it became Apple's default browser beginning with Mac 

OS X v10.3 "Panther." Safari is also the native browser for the iPhone OS. A version of Safari for 

the Microsoft Windows operating system, first released on June 11, 2007, supports Windows XP, 

Windows Vista, and Windows 7. The current stable release of the browser is 4.0.4 for both Mac OS 

X and Windows. 

 

18) Have you any idea about Netscape? 

Netscape's web browser was once dominant in terms of usage share, but lost most of that share to 

Internet Explorer during the first browser war. By the end of 2006, the usage share of Netscape 

browsers had fallen, from over 90% in the mid 1990s, to less than 1%. Netscape developed the 

Secure Sockets Layer Protocol (SSL) for securing online communication, which is still widely used, 

as well as JavaScript, the most widely-used language for client-side scripting of web pages. 

 

19) What you know about Mozilla Firefox? 

Mozilla Firefox is a free and open source web browser descended from the Mozilla Application 

Suite and managed by Mozilla Corporation. A Net Applications statistic put Firefox at 24.41% of 

the recorded usage share of web browsers as of January 2010, making it the second most popular 

browser in terms of current use worldwide after Microsoft's Internet Explorer, and the most used 

browser independent of any one operating system. Other sources put Firefox's usage share at 

between 21% and 32% and generally trending upward. 

 

20) What is Plug-in? 

In web browsers, a plug-in (also called plugin, addin, add-in, addon, add-on, snap-in or snapin) 

consists of a computer program that interacts with a host application  (a web browser or an email 

client, for example) to provide a certain, usually very specific, function "on demand". Add-on is 

often considered the general term 

21).What are the features used by Web browsers? 

- Web browser provides text based user interfaces with the features supporting HTML that are rich in many 

file formats.  

 

- It uses protocols that support the transaction of one form to another form using the web browsers.  
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- Web browsers use the components that support the e-mail or other features like IRC that  

22)What are the privacy and security features being provided by web browsers? 

 

- Web browser supports HTTP secure method that allows more security for the sites that are involved in day 

to day basis transaction.  

 

- Security offers quick and easy way to remove the unwanted material or the things that are stored without 

permission like cache, cookies and history.  

 

- Security is being provided by the use of blockers that blocks unwanted access to the websites from the 

outside.  

 

- Web browser uses other features like disabling of JavaScript and pop up blockers to block any unwanted 

scripts or messages to run on the system. 

 

- Web browser also uses the security concerns in regard of blocking the access to the secure sites that 

provides money transfer facilities, etc.helps in communication purpose with other platforms.  

23) What is the support being provided to web browser? 

 

 

- Web browser supports the HTML version that is used to create the website in a very simple manner 

without using the complex tools. 

 

- Web browser supports rapid development of the websites and tools that can be used for the creation of it.  

24).What are the different web browser tools available to accelerate the speed of the web page? 

 

 

- Web accelerators are used to increase the loading of the web page faster and by providing extra features of 

caching, etc.  

 

- There are tools that are provided like internet accelerator of browser accelerator that provides security from 

the spyware and adware programs.  

 

- The security from the programs are required as they are harmful for the computer and the tools uses the 

strategies of pre-caching in which the data is automatically cached and when the website is opened again 

then the fetching is being done from the place where the content is saved.  

 

- Registry tweaks are used to improve the performance offering the risk management techniques for 

downloading the resources. 

25). What is the way to clear the browser cache? 
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- The browser cache consists of the temporary storage space on the computer’s disk or the device that is 

being used for storing all the information. 

 

- The browser cache consists of the information regarding the recently viewed web pages and the files that 

are in association with them.  

 

- The cache allows the browser to render the pages that are being visited and allow them to reload using the 

entire page.  

26)What is the use of incognito browsing? 

 

 

- Incognito browsing keeps the website secure and safe as it doesn’t store any cookies for the sites that are 

being visited.  

 

- Web pages that are viewed in the incognito mode are not visible in the browser’s history or the search 

history that is being performed.  

 

- No trace is being left of the website being visited as it doesn’t store the cookies or any files.  

 

- It ensures the activities performed by the user are not traced and the security is being provided to the user 

for the use of web application.  

 

- It is the safest methods to use as it leave no track behind and save the user from the sites that ask for 

private information. 

27).What is the purpose of web browser? 

 

 Web browser is used to run the software application that allows retrieving, presenting and traversing the 

information from one place to another.  

28).What is the primary function of the Web browsers? 

 

 

- Web browser functions are to provide the resources or information to the user when asked by them.  

 

- It processes the user inputs in the form of URL like http://www.google.com in the browser and allows the 

access to that page.  

 

- URL is used to identify the resources and fetch them from the server and displays it to the client.  

29).What are the different types of components involved in URI? 
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- URI is known as Uniform Resource Identifier as it identifies the resources requested by clients and fetches 

them from the server.  

 

- The components that are used in URI are as follows: 

 

- http: is the first thing that is used in a URL and it is used to tell what kind of resource that needs to be 

retrieved over the server. 

> This includes the server details and it is itself a protocol known as Hypertext Transfer Protocol (HTTP) 

that is used to fetch the information.  

 

- Web browsers sometimes use the secure protocol that is represented using HTTPs used in case of secure 

transaction over the internet.  

 

- ftp: is also a protocol that is known as File Transfer Protocol that allows the transfer from a file from local 

computer to server. 

30)A website says I have spyware, is it true? 

hose "spyware detected" and similar messages that appear on specific web pages on top of the actual 

content are ads. 

 

 

 

 

 

 

PROBLEM 9: 

Search Engines & Netiquette: Students should know what search engines are and how to use the search engines. A 

few topics would be given to the students for which they need to search on Google. This should be demonstrated to 

the instructors 

AIM: To know what search engines are and how to use the search engines. 

Hardware Requirements: Personal Computer 

Software Requirements: Operating System, Web Browser 

THEORY: 

Search engine: 

A search engine can be defined as a web site with tools which help you to find information on the internet 
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Function of a search engine: 

 Search Engine can the search any data based on keywords, searches on web and finding the locations various web 

sites databases with the related information and gives the different list of results to the Web Browser. 

Limitations: 

 Search engines visit web sites only several weeks. Search engines cannot see information in other data bases later on. 

On the internet a search engine is a coordinated set of programs that includes: A spider (crawler or bot) that goes to 

every page or representative pages on every web site that wants to be searchable and reads it, using hypertext links on 

each page to discover and read site’s other pages.  

Pros: 

 You can select the search terms 

 You can use the same search terms with multiple search engines 

 You can change search terms as much as you wish 

 You will normally receive numerous links 

 Its fast 

Cons: 

 There are so many different search engines it may be difficult to choose 

 You will normally receive too many links often making it difficult to identify the most relevant sites.  

 The vast majority of links may be only marginally relevant or altogether irrelevant 

 

EX: Alta Vista, Ask Jeeves, Google, Lycos, Yahoo, Bing, Etc... 

Meta Search Engines: 

 Meta search engines or “metacrawlers” don’t crawl the web themselves. Instead they search the resources of multiple 

search engines by sending a search to several search engines at once aggregating the result. 

Pros: 

 You only need to use one search tool which is time- efficient 

 You only need to learn how to use one search engine reducing learning curve 

 You benefit from the difference among several search tools at once 

 

Cons: 

 Meta search services may not be able to leverage each individual search engines full range of query 

tools resulting in less refined searches 
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 You can not personally select the search engines queried by Meta search services. 

Ex: DogPile, Mamma, Vivisimo, Meta Search Engine, etc. 

Result: Identification of Search Engine process is completed. 

Viva Questions: 

1) Define search engine? 

Ans: A search engine is a sort of a page that shows the list of all the web sites along with the information on it. 

2) What is a spider? 

Ans: A spider is a program that visits Web sites and reads their pages and other information in order to create 

entries for a search engine index. 

3) What are popular search engines? 

Ans: Google, Yahoo!, Bing, Ask.com, info.com, Meta Crawler, etc. 

4) What is a meta search engine? 

Ans: A metasearch engine is a search tool that sends user requests to several other search engines and/or 

databases and aggregates the results into a single list 

5) Give the main purpose of WWW? 

Ans: WWW (World Wide Web) is a system of interlinked hypertext documents accessed via the Internet. 

6)  What is SEO? 

SEO stands for Search Engine Optimization and It is a process/ technique to optimize your website or 

WebPages according to improve its SERP (Search Engine Result Pages) Ranking. 

 

7)  How many types of SEO, describe? 

Generally SEO techniques categorized in two parts 

1. On-Page SEO 

2. Off-Page SEO 

Onpage SEO contains all measures (that search engines took from the website) on your website coding that 

is fully controlled by the developer. It contains title, meta keywords, meta descriptions, heading tags, 

content optimization etc. In simple words any changes that made within the websites ranging from website 

navigation structure to content placement strategy is known as on-page optimization. 

Offpage SEO Activities that are done outside your website to improve it’s position in Google search result 

is called off page SEO. Generally all link building activities comes in this category. Below is the list of few 

off page methods. 

 Directory Submission 

 Social Bookmarking 
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 Search Engine Submission 

 Profile Submission 

 Business Listing 

 Press Release 

 Article Submission 

 Social Media Submissions 

8)  Which is the popular tool to track your website visitors? 

Google Analytics - This tool is Freemium (Free + Premium) that tracks and reports Website Traffic, like 

how many visitors are online, from which location, how much time they spend time to particular page. You 

can check your website traffic in different segments like traffic from organic search, paid search or direct 

search. You can also monitor your traffic from different devices like Desktop, Mobile, Tablest, I-Phones 

with search keywords and landing pages. 

9)  What is Organic Search and Organic Search Result? 

The searching made through the Search Engines Query box known as Organic Search and the listing of 

pages that appears below the query box is called organic search result. 

10)  What is Black Hat SEO and White Hat SEO? 

Black Hat SEO refers the technique to improve website ranking by breaking the rules, policies of Search 

Engines. Hidden text, Cloaking, Spamdexing etc are some well known Black Hat SEO practices. 

White Hat SEO refers the technique to improve website ranking by following the rules, policies of Search 

Engines like quality content, related Title, Meta tags, H1, etc. 

11)  What are the backlinks? 

All links outside from your own website that link back to your website or webpage are called backlinks. 

12) What is Googlebot? 

Googlebot is software or a program that automatically crawled, indexed and cached the new or old 

webpages over the internet and adds them to Google index. It is also known as spider or crawler. 

13)  What is robots.txt? 

It's a special kind of text file containing the instruction for Crawlers to crawl webpage(s), domains, files or 

directory. We can also instruct to crawlers to not do crawl particular webpage(s), domains, files or directory. 

14)  Where robots.txt file uploaded to hosting directory? 

A robots.txt file is uploaded in home/ root folder on the hosting server. 

15)  Can webpage extension effects the SEO? 

No, extensions do not effect to the SEO. You can use .html, .htm, .asp, .aspx, .php etc depending on used 

technology to create website. 

16)  What is robots.txt and how it is useful for SEO? 
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robots.txt enables restricting crawling where it is not needed. This file has set of instruction that tell to the 

Search Engines to access and not to crawl any part of the website. 

17)  What do webmaster tools do? 

The webmaster tools do following things: 

 Analyzing of robots.txt file. 

 Analyzing pages of website which are not opening and optimized. 

 Submit URL to crawl by Search Engine. 

 Remove already crawled URL from Search Engine Database. 

 Specifying preferred domains. 

 Analyzing issues with Title, Meta Description, Image Alt and Anchor Tags. 

 To display crawling and indexing errors. 

 Identifying that website is mobile friendly or not. 

 Submit and Analyze sitemap file. 

 Display total submitted indexed pages in the Search Engine Database. 

18)  What are the some popular Search Engines? 

Google, Bing, Ask, Yahoo!, DuckDuckGo 

19)  What is keyword stuffing? 

To use littering keywords that are not relevant to the page, and using of same keywords on the multiple 

pages known as keyword stuffing, to fix this issues use Unique and Meaning, Descriptive keywords for 

different pages. 

20)  What is Search Engine Submission? 

Webmasters and Website owners need to submit their website and web pages to the search engines along 

with the keywords, soon after submission the website and web page URL a Search Engine bot will crawl 

submitted URL and update the URL in their indexes. 

PROBLEM 10: 

Cyber Hygiene: Students would be exposed to the various threats on the internet and would be asked to configure 

their computer to be safe on the internet. They need to first install an antivirus software, configure their personal 

firewall and windows update on their computer. Then they need to customize their browsers to block pop ups, block 

active x downloads to avoid viruses and/or worms 

AIM: To learn various threats on the internet and configure the computer to be safe on the internet. 

Hardware Requirements: Personal Computer 

Software Requirements: Operating System, Antivirus Software 

THEORY: 

Antivirus: 
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Antivirus software is a program that either comes installed on your computer or that you purchase and install yourself. 

It protects your computer against most viruses, worms, Trojan horses and other unwanted invaders that can make your 

computer sick. 

Firewall: 

A firewall is a special software or hardware designed to protect a private computer network from unauthorized access. 

A firewall is a set of related programs located at a network gateway server which protects the resources of the private 

network from users from other networks. 

Types of Internet Threats 

 Viruses 

 Network Worms 

 Trojans 

 Spyware / Adware 

 Other Malware 

 Other Threats 

Viruses 

 Main purpose is to spread and infect files 

 Attach to a file and replicate when file is executed  

 More than 100 000 known viruses exists in the world today 

 Several hundred new viruses are discovered every month 

Network Worms 

 Self-replicating Viruses that reside in the active memory of a computer. 

 Worms send themselves out to the Internet from infected systems.  

 Either include tiny e-mail server or search for unprotected shared network drives to unload.   

Trojan Programs 

Programs that installs themselves stealthily via Internet & provide access for malicious use 

Threats enabled by (/through) Trojans 

 Data stealing 

 Distributed spam eMails 

Spyware / Adware 

 Cookies – Track you online 

 Browser Hijackers – Changes default home page  

 Tracking Cookies – Gathers info of web usage 

Other Threats 
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 Phishing 

 Confidential information stealing by fraud emails & web sites (author falsified) 

 Several millions of Phishing messages have been sent world wide 

 Fastest growing threat today 

PROCEDURE: 

Installing Symantec antivirus for Windows: 

 Insert  Symantec antivirus CD into your CD drive 

 Double click  on the Symantec-setup.exe 

 The installer will open  

 Click next to proceed 

 License agreement will open. Click I accept the terms of the license agreement and then click next. 

 Follow the instruction on the screen to complete the installation. 

Block Pop ups: 

 In the IE open  tools>pop-up blocker 

 Click on Turn on Pop- up blocker 

Windows Firewall: 

 Go to  Start>control panel>Network and Internet Connections>windows firewall 

 In the general tab check the On(recommended) box 

 If you don’t want any exceptions check on  Don’t allow exceptions box 

Result: Identification of various threats, attacks, worms from Internet and Installation of Antivirus Software is 

completed. 

 

Viva Questions: 

1) What is antivirus software? 

Ans: Anti Virus Software is a program that installed on your computer, it helps to protect your computer against 

most viruses, worms, Trojan Horses, etc. 

2) Define virus 

Ans: Virus is a program which performs malicious acts, such as deleting files, accessing personal data, or using 

your computer to attack other computers. 

3) Define worm? 

Ans: Worms are self replicating viruses that reside in the active memory of computer. 

4) What are the advantages of antivirus software? 

Ans: By using Anti Virus Software you can keep your computer healthy and protects from malicious acts. 



89 
ITWORKSHOP LAB MANUAL  

5) What are the types of antivirus software’s available? 

Ans: Avast, Antivira, Kaspersky, QuickHeal, Symantec, AVG, Etc. 

6) What Is The Malware? 

 

 

A is software used or created to disrupt computer operation, gather sensitive information, or gain access 

to private computer systems. 

It can appear in the form of code, scripts, active content, and other software. 

Malware' is a general term used to refer to a variety of forms of hostile, intrusive, or annoying software 

 

7)  What Are The Uses Of Usage Of Malware? 

 

Many early infectious programs, including the first Internet Worm, were written as experiments or 

pranks. 

Today, malware is used primarily to steal sensitive personal, financial, or business information for the 

benefit of others. 

• Malware is sometimes used broadly against government or corporate websites to gather guarded 

information, or to disrupt their operation in general. 

However, malware is often used against individuals to gain personal information such as social security 

numbers, bank or credit card numbers, and so on. 

 

8) What Are The Types Of Malware? 

 

      Viruses 

Trojan horses  

Worms 

Spyware  

Zombie  

Phishing  

Spam  

Adware  

Ransomware 

 

9) What Is A Virus? 

 

A program or piece of code that is loaded onto your computer without your knowledge and runs against 

your wishes. 

Viruses can also replicate themselves. 

All computer viruses are manmade. 

Viruses copy themselves to other disks to spread to other computers. 

They can be merely annoying or they can be vastly destructive to your files. 

  

10)  Give Few Examples Of Viruses? 

 

Macro virus. 

Boot virus. 

Logic Bomb virus. 

Directory virus. 

Resident virus. 

 

11) What Is Trojan Horse?  
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A Trojan Horse program has the appearance of having a useful and desired function. 

A Trojan Horse neither replicates nor copies itself, but causes damage or compromises the security of 

the computer. 

A Trojan Horse must be sent by someone or carried by another program and may arrive in the form of a 

joke program or software of some sort. 

These are often used to capture your logins and passwords. 

 

12) Give Few Examples? 
 

Example of Trojan Horses : 

Remote access Trojans (RATs) 

Backdoor Trojans (backdoors) 

IRC Trojans (IRCbots) 

Keylogging Trojans 

 

 

13) What Are Worms? 

 

A computer worm is a self-replicating computer program. 

It uses a network to send copies of itself to other nodes (computers on the network) and it may do so 

without any user intervention. 

It does not need to attach itself to an existing program. 

 

14) What Is Spyware? 

 

Spyware is a type of malware installed on computers that collects information about users without their 

knowledge.  

The presence of spyware is typically hidden from the user and can be difficult to detect. 

Spyware programs lurk on your computer to steal important information, like your passwords and logins 

and other personal identification information and then send it off to someone else. 

 

15)  What Is Zombie? 

 

Zombie :  Zombie programs take control of your computer and use it and its Internet connection to 

attack other computers or networks or to perform other criminal activities. 

 

 

16) What Is Phishing? 

 

• Phishing (pronounced like the word 'fishing') is a message that tries to trick you into providing 

information like your social security number or bank account information or logon and password for a 

web site. 

 

• The message may claim that if you do not click on the link in the message and log onto a financial web 

site that your account will be blocked, or some other disaster. 

 

17) What Is Ransomware? 

 

 

Ransomware is a form of malware that essentially holds a computer system captive while demanding a 

ransom. 
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The malware restricts user access to the computer either by encrypting files on the hard drive or locking 

down the system and displaying messages that are intended to force the user to pay the malware creator 

to remove the restrictions and regain access to their computer. 

 

18)  What Is Spam? 

 

Spam is email that you did not request and do not want. 

One person's spam is another's useful newsletter or sale ad. 

Spam is a common way to spread viruses, trojans, and the like. 

 

19)  What Is Adware? 

 

Adware (short for advertising-supported software) is a type of malware that automatically delivers 

advertisements. 

Common examples of adware include pop-up ads on websites and advertisements that are displayed by 

software. 

Often times software and applications offer “free” versions that come bundled with adware.  

 

20) How Malware Spreads? 

 

Malware is a program that must be triggered or somehow executed before it can infect your computer 

system and spread to others. 

 

Here are some examples on how malware is distributed: 

 

Social network. 

Pirated software. 

Removable media. 

Emails. 

Websites. 

 

 

 
PROBLEM 9: 

Develop your home page using HTML consisting of your photo, name, address and education details as a table 

and your skill set as a list. 

AIM: To create home page using HTML  

Hardware Requirements: Personal Computer 

Software Requirements: Operating System, Web Browser, Notepad 

THEORY: 

HTML is a language for describing web pages. HTML stands for Hyper Text Markup Language. A markup 

language is a set of markup tags. The tags describe document content. HTML documents contain HTML tags and 

plain text. HTML documents are also called web pages. 

HTML tags are keywords (tag names) surrounded by angle brackets like <html>.HTML tags normally come 

in pairs like <b> and </b> i.e. Start Tag (<>) and End Tag (</>). 
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HTML Page Structure 

<html> 

<head> 

<title>Title of the Document </title> 

</head> 

<body> 

………. 

</body> 

</html> 

 The text between <html> and </html> describes the web page 
 The text between <body> and </body> is the visible page content 

 The text between <head> and </head> is the description about the document. 

 The text between <title> and </title> shows the title of the document 

HTML Versions 

Version Year 

HTML 1991 

HTML+ 1993 

HTML 2.0 1995 

HTML 3.2 1997 

HTML 4.01 1999 

XHTML 1.0 2000 

HTML5 2012 

XHTML5 2013 

Basic HTML Tags: 

 

S.No. Tag Description Example 
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1 <!--...--> Defines a comment <!--This is a comment. Comments are not 
displayed in the browser--> 

2 <a> Defines a hyperlink <a href="http://www.google.co.in">Google</a> 

3 <abbr> Defines an abbreviation The <abbr title="Hyderabad">HYD</abbr> 

4 <audio>Ne

w 

Defines sound content <audio> 
   <source src="horse.mp3" type="audio/mpeg"> 

</audio> 

5 <b>  Defines bold text <b>and this is bold text</b> 

6 <body>  Defines the document's body <body>The content of the document....</body> 

7 <br> Defines a single line break This text contains<br>a line break. 

8 <caption>  Defines a table caption <caption>Caption for Table</caption> 

9 <center>  Defines centered text <center>This text will be center-
aligned.</center> 

10 <dl>  Defines a description list <dl> 
  <dt>Coffee</dt> <dd>Black hot drink</dd>  

</dl> 

11 <footer>N Defines a footer for a document or section <foter>Page No:1</footer> 

12 <frame>  Defines a window (a frame) in a frameset <frameset cols="25%,*,25%"> 

  <frame src="frame_a.htm"> 
  <frame src="frame_b.htm"> 

  <frame src="frame_c.htm"> 
</frameset> 

13 <frameset>  Defines a set of frames 

14 <h1> to 
<h6>  

Defines HTML headings <h1>This is heading 1</h1> 

<h2>This is heading 2</h2> 
<h3>This is heading 3</h3> 

<h4>This is heading 4</h4> 

<h5>This is heading 5</h5> 
<h6>This is heading 6</h6> 

15 <head>  Defines information about the document <head> 
<title>Title of the document</title> 
</head> 

http://www.w3schools.com/tags/tag_comment.asp
http://www.w3schools.com/tags/tag_a.asp
http://www.w3schools.com/tags/tag_abbr.asp
http://www.w3schools.com/tags/tag_audio.asp
http://www.w3schools.com/tags/tag_b.asp
http://www.w3schools.com/tags/tag_body.asp
http://www.w3schools.com/tags/tag_br.asp
http://www.w3schools.com/tags/tag_caption.asp
http://www.w3schools.com/tags/tag_caption.asp
http://www.w3schools.com/tags/tag_dl.asp
http://www.w3schools.com/tags/tag_footer.asp
http://www.w3schools.com/tags/tag_frame.asp
http://www.w3schools.com/tags/tag_frameset.asp
http://www.w3schools.com/tags/tag_hn.asp
http://www.w3schools.com/tags/tag_hn.asp
http://www.w3schools.com/tags/tag_head.asp
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16 <hr>  Defines a thematic change in the content <p> </p><hr> Horizontal line<p></p> 

17 <html>  Defines the root of an HTML document <html>   </html> 

18 <i> Italic the Text <i> Italic Word </i> 

19 <img>  Defines an image <img src="smiley.gif" height="42" width="42"> 

20 <li>  Defines a list item <li>Coffee</li> 
  <li>Tea</li> 

21 <mark>ew Defines marked/highlighted text <mark>text background color</mark> 

22 <ol>  Defines an ordered list <ol> 

  <li>Coffee</li> 
  <li>Tea</li> 
 </ol> 

23 <p>  Defines a paragraph <p>This is some text in a paragraph.</p> 

24 <select>  Defines a drop-down list <select> 

  <option value="volvo">Volvo</option> 

   <option value="mercedes">Mercedes</option> 
 </select> 

25 <small>  Defines smaller text <small>shows small text</small> 

26 <table>  Defines a table <table border="1"> 

  <tr> 
    <th>Month</th> 

    <th>Savings</th> 

  </tr> 

  <tr> 
    <td>January</td> 

    <td>$100</td> 

  </tr> 
</table> 

27 <td>  Defines a cell in a table 

28 <tr> Defines a row in a table 

29 <th>  Defines a header cell in a table 

30 <textarea>  Defines a multiline input control (text area) <textarea rows="4" cols="50"> 
Enter the message   
</textarea> 

31 <thead>  Groups the header content in a table <thead> 

    <tr> 

      <th>Month</th> 
      <th>Savings</th> 

    </tr> 
  </thead> 

http://www.w3schools.com/tags/tag_hr.asp
http://www.w3schools.com/tags/tag_html.asp
http://www.w3schools.com/tags/tag_i.asp
http://www.w3schools.com/tags/tag_img.asp
http://www.w3schools.com/tags/tag_li.asp
http://www.w3schools.com/tags/tag_mark.asp
http://www.w3schools.com/tags/tag_ol.asp
http://www.w3schools.com/tags/tag_p.asp
http://www.w3schools.com/tags/tag_select.asp
http://www.w3schools.com/tags/tag_small.asp
http://www.w3schools.com/tags/tag_table.asp
http://www.w3schools.com/tags/tag_td.asp
http://www.w3schools.com/tags/tag_tr.asp
http://www.w3schools.com/tags/tag_th.asp
http://www.w3schools.com/tags/tag_textarea.asp
http://www.w3schools.com/tags/tag_thead.asp
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32 <title>  Defines a title for the document <title>HTML Reference</title> 

33 <ul>  Defines an unordered list <ul> 

  <li>Coffee</li> 
  <li>Tea</li> 

  <li>Milk</li> 
</ul> 

34 <u> Defines text that should be stylistically 
different from normal text 

<p>This is a <u>paragraph</u>.</p> 

35 <marquee> The marquee tag used to scroll the text  up, 
down, left or right. 

<marquee direction="right">Welcome to 

HTML</marquee> 

 

 

TASK: Creating a Student Personal Profile as a Web Page 

 

HTML Code: 

<html> 

<head> 

<title> Personal Data </title> 

</head> 

<body> 

<marquee direction="right">Welcome to HTML</marquee> 

<header><u><center><b>Personal Profile</b></center></u><header> 

<text> 

Name: <br> 

Father Name: <br> 

Date of Birth:  <br> 

<img src="New Picture.png" height="150" width="150" align="right" hspace="500"><br> 

Address: <br><textarea columns=15 rows=4></textarea> <br> 

<u><b>Education Details</b></u><br> 

<table border="1"> 

  <tr> 

http://www.w3schools.com/tags/tag_title.asp
http://www.w3schools.com/tags/tag_ul.asp
http://www.w3schools.com/tags/tag_u.asp
../Downloads/Local%20Settings/My%20Documents/Downloads/marquee
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    <th>S.No.</th> 

    <th>Qualification</th> 

    <th>College/University</th> 

    <th>Year passing</th> 

    <th>Percentage></th> 

  </tr> 

  <tr> 

    <td>1</td> 

    <td>SSC</td> 

    <td>AP Board</td> 

    <td>2003</td> 

    <td>72</td> 

  </tr> 

  <tr> 

    <td>2</td> 

    <td>Intermediate</td> 

    <td>AP Board</td> 

    <td>2005</td> 

    <td>72</td> 

  </tr> 

  <tr> 

    <td>3</td> 

    <td>B.Tech</td> 

    <td>JNTUH</td> 

    <td>2009</td> 

    <td>66</td> 

  </tr> 

  <tr> 

    <td>4</td> 

    <td>M.Tech</td> 



97 
ITWORKSHOP LAB MANUAL  

    <td>JNTUH</td> 

    <td>2012</td> 

    <td>70</td> 

  </tr> 

</table> 

<b><u>Skill Set:</b></u> 

<ul> 

<li>Cricket Player</li> 

<li>Won 1st Prize in School Quiz competiotion</li> 

<li>etc.</li> 

</ul> 

</body> 

</html> 

 

 

 

 

 

 

 

OUTPUT: 
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Result: Creating a Sample Web Page for student personal profile is completed by using HTML Tags. 

  

 

 

Viva Questions: 

1) What is HTML? 

Ans: HTML is a Hyper Text Markup Language used to design the Web Pages 

2) What are the extensions to a HTML page while saving in a Notepad? 

Ans: .html, .htm 

3) How can you include comments in HTML?  

Ans: An HTML comment begins with "<!--", ends with "--> 

Ex: <!-- This is a comment. --> 

4) What is <title> tag? 

Ans: It shows the title of the HTML page  

5) What is <br> tag? Is there any end tag for this like </br>? 



99 
ITWORKSHOP LAB MANUAL  

Ans: It is used to separate the lines or to start with a new line. End tag </br> is required for this tag. 

6) What is semantic HTML? 

Semantic HTML is a coding style. It is the use of HTML markup to reinforce the semantics or meaning 

of the content. For example: In semantic HTML <b> </b> tag is not used for bold statement as well as 

<i> </i> tag is used for italic. Instead of these we use <strong></strong> and <em></em> tags. 

7) What is image map? 

Image map facilitates you link many different web pages using a single image. You can define shapes in 

images that you want to make part of an image mapping. 

8) How to insert a copyright symbol on a browser page? 

can insert a copyright symbol by using &copy; or &#169; in an HTML file. 

9) How do you keep list elements straight in an HTML file? 

You can keep the list elements straight by using indents. 

10) Does a hyperlink only apply to text? 

No, you can use hyperlinks on text and images both.   

11) What is a style sheet? 

A style sheet is used to build a consistent, transportable, and well designed style template. You can add 

these templates on several different web pages. 

12) Can you create a multi colored text on a web page? 

Yes. To create a multicolor text on a web page you can use <font color ="color"> </font> for the specific 

texts you want to color. 

13) Is it possible to change the color of the bullet? 

The color of the bullet is always the color of the first text of the list. So, if you want to change the color of 

the bullet, you must change the color of the text. 

14) What is a marquee? 

Marquee is used to put the scrolling text on a web page. You should put the text which you want to scroll 

within the <marquee>......</marquee> tag.   

 

15) How many tags can be used to separate section of texts? 

There are three tags used to separate the texts. i.e. usually <br> tag is used to separate line of texts. Other 

tags are<p> tag and <blockquote> tag. 
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16) How to make a picture a background image of a web page? 

To make a picture a background image on a web page, you should put the following tag code after the 

</head> tag. 

1. <body background = "image.gif">   

Here, replace the "image.gif" with the name of your image file which you want to display on your web 

page. 

17) What are empty elements? 

HTML elements with no content are called empty elements. For example: <br>, <hr> etc. 

18) What is the use of span tag? Give one example. 

The span tag is used for following things: 

o For adding color on text 

o For adding background on text 

o Highlight any color text etc. 

Example: 

1. <p>   

2. <span style="color:#ffffff;">   

3. In this page we use span.   

4. </span>   

5. </p>   

 

19) What is the use of iframe tag? 

An iframe is used to display a web page within a web page. 

Syntax: 

1. <iframe src="URL"></iframe>   

Example: 

1. <iframe src="demo_iframe.html" width="200px" height="200px"></iframe>   

Target to a link: 

1. <iframe src="http://www.javatpoint.com" name="iframe_a"></iframe>   
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20) What is SVG? 

HTML SVG is used to describe the two dimensional vector and vector/raster graphics.   

21) Can attribute values be set to anything or are there specific values that they accept? 

Some attribute values can be set to only predefined values. Other attributes can accept any numerical value 

that represents the number of pixels for a size. 

21) How do you insert a copyright symbol on a browser page? 

 

To insert the copyright symbol, you need to type &copy; or & #169; in an HTML file. 

22) How do you create links to sections within the same page? 

 

Links can be created using the <a> tag, with referencing through the use of the number (#) symbol. For 

example, you can have one line as <a href=”#topmost”>BACK TO TOP</a>, which would result in the 

words “BACK TO TOP” appearing on the webpage and links to a bookmark named topmost. You then 

create a separate tag command like <a name=”topmost”> somewhere on the top of the same webpage so that 

the user will be linked to that spot when he clicked on “BACK TO TOP”. 

24) Is there any way to keep list elements straight in an HTML file? 

By using indents, you can keep the list elements straight. If you indent each subnested list in further than the 

parent list that contains it, you can at a glance determine the various lists and the elements that it contains. 

25) If you see a web address on a magazine, to which web page does it point? 

Every web page on the web can have a separate web address. Most of these addresses are relative to the top-

most web page. The published web address that appears within magazines typically points this top-most 

page. From this top level page, you can access all other pages within the website. 

26) What is the use of alternative text in image mapping? 

When you use image maps, it can easily become confusing and difficult to determine which hotspots 

correspond to which links. Using alternative text lets, you put a descriptive text on each hotspot link. 

27) Do older HTML files work on newer browsers? 

Yes, older HTML files are compliant to the HTML standard. Most older files work on the newer browsers, 

though some features may not work. 

28) Does a hyperlink apply to text only? 

No, hyperlinks can be used in the text as well as images. That means you can convert an image into a link 

that will allow users to link to another page when clicked. Surround the image within the <a href=” 

“>…</a> tag combinations. 

29) If the user’s operating system does not support the needed character, how can the symbol be 

represented? 

In cases wherein their operating system does not support a particular character, it is still possible to display 

that character by showing it as an image instead. 

30) How do you change the number type in the middle of a list? 
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The <li> tag includes two attributes – type and value. The type attribute can be used to change the 

numbering type for any list item. The value attribute can change the number index. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

PROBLEM 10: 
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To create project certificate, Features to be covered:-Formatting Fonts in word, Drop Cap in word, Applying 

Text effects, Using Character Spacing, Borders and Colors, Inserting Header and Footer, Using Date and Time 

option in Word and Latex 

i) AIM: To create a document applying the above mentioned techniques. 

Hardware Requirements: Personal Computer 

Software Requirements: Operating System, MS Office Package (MS- Word Application) 

MS- WORD 2007: 

 

 The HOME Tab includes commands related to the Clipboard, font selections, paragraph settings, and styles 

and editing. 

 The INSERT tab includes what you need to add pages, tables, illustrations, links, headers and footers, text 

objects, and symbols in your document. 

 The PAGE LAYOUT tab contains the commands for working with themes page backgrounds, and paragraph 

spacing in your document. 

 The REFERENCES tab includes special elements you will use when you create longer or more complete 

documents. 

 The MAILINGS tab is a new addition in the Office Word 2007 interface. Here you can find everything you 

need to creating, previewing, and producing a mail merge project. 

Ribbons or Tool Bars: 
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Creating and Saving a File: 

 The Office Button is the round icon at the top left-hand corner. It includes the basic File 

Functions from the older version of Office  

 New, Open, Save, Save As, Print, etc.  

Click on the Office Button icon. You will see the main file functions in the pull-down menu.  

From these options you can Create a File, you can open existed files, save a file, Save As option 

to save another copy with another name, print option, close option, etc. 

 

 

Rulers and Scroll Bars: 

 

Ruler and Scroll Bar (Top)                               Ruler and Scroll Bar (Bottom) 

 

Status Bar 
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THEORY:  

    Drop cap: To create a large dropped initial capital letter 

 

  

      Header and Footer: 

1. To create a header, enter text or graphics in the header area or click button on the header and footer 

tool bar. 

                    2. To create footer, click switch between header and footer. 

                    3. Then click exit. 

 

       Border: 

On the format menu, click borders and shadings. 

To specify that the border appears on a particular side of a page, such as only at the top, click custom under 

setting. 

To specify a particular page or section for the borders to appear, click the option you want to apply. 

To specify the exact position of the border on the page. 

Finally, click OK. 

 

      Color: 
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Select the text you want to make a different color. 

To apply the color most recently applied to text, click font color. 

To apply different colors, click the arrow on the right of the font color button, select the color you want and 

then click the button.  

 

Result: Creation of project Certificate using MS Word completed successfully by applying different options.  

Viva Questions: 

1) What is the function of Menu Bar? 

Ans: Menu Bar displays the menu; we use the menus to give the instructions to the software. 

2) What is a Status Bar? 

Ans: Status Bar provides information as current page, current section, total no of pages, inches from the 

top of the page, current line number and column number. 

3) Point out different types of Scroll Bars? 

Ans: Different Scroll Bars are Horizontal Scroll Bar and Vertical Scroll Bar. 

4) What is the extension of Microsoft Word file? 

Ans: The extension of word 2003 file is .doc and for word 2007 .docx 

5) How can you justify the text in MS- Word? 

Ans: To justify the text you can click on Justify option in Styles and Formatting Tool Bar or Press 

Ctrl+J. 

6) How do you create a document in Microsoft Word from scratch?  

In the upper-left corner of the Word program window, click the File tab, and then click New. The 

New Document dialog box opens. With Blank document selected, click Create. 

7) How do you save a document in Microsoft Word?  



107 
ITWORKSHOP LAB MANUAL  

To save a document for the first time, you can press Ctrl+S, click the Save button on the Quick 

Access toolbar, or click Save on the File tab. All three options display a dialog box in which you 

specify a name for the document. 

8) How do you track changes to documents?  

You can use Word's Track Changes feature to record the changes made to a document. Click the 

Track Changes button in the Tracking group on the Review tab. Word highlights the button, 

indicating that the Track Changes feature is turned on.  

9) How do you format text, change font, and font size?  

   To format text, in the Font group on the Home tab, click the Bold, Italic or Underline button. To 

change the font and font size click on the toolbar. Click the Font arrow to display a list of available 

fonts. Then click the Font Size arrow to select the size.  

10) What will the following key combination do: Ctrl+P?  

Ctrl+P will print the document.  

11) How do you check spellings and grammar of a MS Word document?  

Place the cursor at the beginning of the document or at the beginning of the section that you want to 

check. Click the Review tab on the tool bar. Click Spelling & Grammar on the Proofing group.  

12)  How do you create a spreadsheet in Microsoft Excel from scratch?  

    When you start Excel without specifying a document to open you get a blank workbook in a new 

workbook window. This workbook, temporarily named Book1, contains three blank worksheets 

(Sheet1, Sheet2, and Sheet3). To begin to work on a new spreadsheet, you simply start entering 

information in the first sheet of the Book1 workbook window.  

13) How do you save a spreadsheet in Microsoft Excel? 

 Click the Save button on the Quick Access toolbar or press Ctrl+S; then designate the drive and 

folder directory where the file should be located.  

14) How do you print a spreadsheet in Microsoft Excel?  

First, use the Print Preview feature before you print any worksheet to see exactly how the worksheet 

data will be paged when printed. You then can click the print icon in the toolbar.  

15) How do you format cells in a spreadsheet?  

First, you highlight the entire block of cells you wish to format. You then can either right click the 

block of cells to format or select one of the formatting buttons on the toolbar. Microsoft PowerPoint  

16) How do you create a new presentation?  

You would click the Office button to open the File menu and choose New to display the New 

Presentation window. Double-click Blank Presentation to open a new presentation based on the 

blank template.  
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17) How do you view your presentation in full screen mode?  

Click the Slide Show view button to display the slide show starting with the currently selected slide.  

18) How do you save a PowerPoint presentation?  

Click the Office button and choose Save from the File menu to display the Save As dialog box. Type 

a name for the document and then click save.  

19) How do you build a slide in a blank presentation?  

Click the New Slide button to insert a new title and content slide. To change the layout click the 

arrow on the New Slide button and click another option from the drop-down box to insert a slide 

with a different layout.  

20) How do you apply a transition to a slide?  

Select the slide you wish to modify. Click on the Transitions tab. Locate the preferred transition 

type to apply. Click on the transition to apply it to the selected slide. 

Procedure: 

 

1.  Insert Date from “Date and Time” Option. 

2.  Form Field – Text Form Field 

a.  To display the Forms toolbar, point to Toolbars on the View menu, and then click Forms. 

b.  In the document, click where you want to insert the form field. c.  Click Text 
Form Field. 

3.  Form Field – Drop-Down Form Field 

a.  In the document, click where you want to insert the form field. b.  Click Drop-
Down Form Field. 

c.  If needed, a user can scroll through the list to view additional choices. 

d.  To edit these fields, you must use the Form Field Options button on the 

Forms toolbar. 

4.  Form Field – Check Box Form Field 

a.  In the document, click where you want to insert the form field. b.  Click Check 
Box Form Field. 

c.  To edit these fields, you must use the Form Field Options button on the 

Forms toolbar. 

5.  Mail Merge 

a.  On the Tools menu, point to Letters and Mailings, and then click Mail 

Merge. 

b.  Word displays the Mail Merge task pane. 
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c.  Select type as “Letters” and click “Next: Starting Document”. 

d.  Click Use the current document, and Click “Next: Select recipients”. e.  Under Select 
recipients, click Use an existing list. 

f.   Click Browse. 

g.  In the Select Data Source dialog box, locate and click the data source you want. 

h.  Browse for the given “List.txt” file., and Click Open. 

i.   All of the entries in the data source appear in the Mail Merge 

Recipients dialog box, where you can refine the list of recipients to include in the 
merge. 

j.   Click Next: Write your letter. 

k.  Click on the location where you want to put a merge field. Click on more items. 

l.   Select and Insert the merge field at that location. 

m. Click Next: Preview your letters. 

n.  To preview the items in order, click the arrow buttons. 

o.  To exclude a particular recipient from the merge, click Exclude this recipient. 

p.  Click Next: Complete the merge. 

q.  You can either print all the letters or Edit individual letters 

i.  Click Edit individual letters. 

ii.  To merge all the documents, click All. 

iii.  Save it to a separate document for future use.
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MICROSOFT EXCEL 

Microsoft Excel is one of the most widely used Spreadsheet applications for performing financial, statistical and 

computational analysis for the purpose of business and administration. 

 

The tool is so flexible enough to get integrated with other applications for providing the best output. For instance, it can be 

integrated to web servers and the students marks, percentile etc. calculated can be generated onto the web. Similarly it can be 

integrated with the other Office Applications for providing Charts, Statistics etc. It can also be used as a backend 

database for any applications involving high-end calculation of the data that is stored. 
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MICROSOFT POWER POINT 

 

PowerPoint is  a  high-powered software tool  used  for  presenting information in  a dynamic slide show format. Text, 

charts, graphs, sound effects and video are just some of the elements PowerPoint can incorporate into your presentations with 

ease. Whether it's a classroom lesson, a parents' group meeting, a teachers' seminar - PowerPoint shows you how to make a 

powerful impression on your audience 

 

Task 20: Create the presentation using the following tools: 

 

1.       Formatting: Color, font type, font size, font style etc. 

2.       Header and Footer 

3.       Bullets and Numbering 

4.       Drawing Toolbar: Auto shapes, Textboxes, etc 

5.       Design Template 

6.       Introduction to custom animation. 

 

Task 21: Create a presentation to conduct a creativity session using the following tools: 

 

1.       Slide transition 

2.       Master slide view 

3.       Insert picture – clipart, image 

4.       Action button 

5.       Drawing tool bar – lines, arrows 

6.       Hyperlink 

7.       Custom animation 

8.       Hide slide 

9.       Wash out 

Task 22: Business Presentation 

Create a presentation to build relationships, think creatively and market your product using the following tools: 

 

1.       Slide Layout 

2.       fill color 

3.       Inserting object, picture (effects), graph, word art 
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4.       comments 

5.       Security – password 

6.       Tables and Borders 

7.       Rehearse timings 

8.       Recording Narrations 

9.       Audio and video files 

10.     Inserting files, merging files, creating custom shows
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Task 23: 

Create a website for your college. The website should have the following pages 

1.  Homepage which describes the college website 

2.  About Us page which tells about the college vision, when it was established...etc 

3.  Departments page which describes the departments in the college 

4.  Separate pages for the departments of your college 

5.  Contact page which contains address and contact information about the college 

Guidelines for the website are given below: 

 

Homepage 
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Task 23: Repeat the tasks 12-15 using LaTex. 

PROBLEM 11:  

Formatting Styles, Inserting table, Bullets and Numbering, Changing Text Direction, Cell alignment, Footnote, 

Hyperlink, Symbols, Spell Check and  Track Changes. 

AIM: To create a project document applying the above mentioned techniques. 

Hardware Requirements: Personal Computer 

Software Requirements: Operating System, MS Office Package (MS- Word Application) 

THEORY:   

      Table: 

   A table consists of rows and columns. 

 

 

 

       

 

 

Cell Alignment: 

  Aligns a contents written in a table in the top left corner or top right corner or in the center etc.. 
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Foot Note:   

oot notes are used to comments on, or provide references for text in a document. 

 

 

 

 

 

  Hyperlink: It is a colored and underlined text or a graphic that you click to go to a file, a location in a file, an HTML 

page on the World Wide Web, or an HTML page in an intranet. 

 

 

 

 

 

Symbols: You may not be able to enter certain symbols into your word document, as there si a limitation on the keys on 

the key board. Creating these new symbols especially when working with mathematical terms it becomes very difficult 

.For example we can insert symbols such as ,,, ..  

 

Spell check: It automatically checks for spelling and grammatical errors 

 

 

 

 

Bullets and Numbering: In 

Microsoft word we can easily create bulleted or numbered list of items. 
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Formatting Styles: 

A style is a set of rules to be followed for the effective document. Style can be applied to text, paragraph, table or a list. 

 

 

 

 

Procedure: 

Table: 

1. Click where you want to create a table. 

2. On the Insert menu, Click on Table. 

3. Under Table size, select the number of columns and rows. 

4. Under AutoFit behavior, choose options to adjust table size. 

5. To use a built-in table format, click AutoFormat. 

Select the options you want 

Cell Alignment: 

1. Click the cell that contains text you want to align.  

2. On the Tables and Borders toolbar, select the option for the horizontal and vertical alignment you want— for 

example, Align Bottom Center or Align Top Right.  

Foot Note: 

1. In References Menu, click where you want to insert the note reference mark and then click Footnote.  
2. Click Footnotes or Endnotes.  

3. In the Number format box, click the format you want.  

4. Click Insert.  



117 
ITWORKSHOP LAB MANUAL  

Word inserts the note number and places the insertion point next to the note number. 

5. Type the note text.  

6. Scroll to your place in the document and continue typing.  

As you insert additional footnotes or endnotes in the document, Word automatically applies the correct 

number format. 

Hyper link: 

Select the text or picture you want to display as the hyperlink, and then click Insert Hyperlink on the Standard 

toolbar 

Do one of the following:  

1. Link to an existing file or web page: 

1. Under Link to, click Existing File or Web Page. 
2. In the Address box, type the address you want to link to or, in the Look in box, click the down arrow, and 

navigate to and select the file 

2. Link to a file you haven’t created yet 

Under Link to, click Create New Document. 

3. In the Name of new document box, type the name of the new file.  

4. Under When to edit, click either Edit the new document later or Edit the new document now 

An e-mail address: 

1. Select the text or picture you want to display as the hyperlink, and then click Insert Hyperlink on the 

Standard toolbar 

2. Under Link to, click E-mail Address. 
3. Either type the e-mail address you want in the E-mail address box, or select an e-mail address in the recently used 

e-mail addresses box.  

4. In the Subject box, type the subject of the e-mail message 

A specific location in another document  

1. Insert a bookmark in the destination file or Web page.  
2. Open the file that you want to link from, and select the text or object you want to display as the hyperlink.  

3. On the Standard toolbar, click Insert Hyperlink .  

4. Under Link to, click Existing File or Web Page.  

5. In the Look in box, click the down arrow, and navigate to and select the file that you want to link to.  

6. Click Bookmark, select the bookmark you want, and then click OK. 

 

Symbol: 
1. Click where you want to insert the symbol.  

2. On the Insert menu, click Symbol, and then click the Symbols tab.  

3. In the Font box, click the font that you want.  
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4. Double-click the symbol that you want to insert.  
5. Click Close 

Spell check: 

1. On the Review Menu, click Spelling and Grammar   

2. When Word finds a possible spelling or grammatical problem, make your changes in the Spelling and Grammar 

dialog box.  

Bullets and Numbering: 

1. Type 1. to start a numbered list or * (asterisk) to start a bulleted list, and then press SPACEBAR or 

TAB. 

2. Type any text you want. 

3. Press ENTER to add the next list item. 

Word automatically inserts the next number or bullet. 

4. To finish the list, press ENTER twice, or press BACKSPACE to delete the last bullet or number in the 

list 

Formatting Styles: 

1. Select the words, paragraph, list, or table you want to change.  

2. If the Styles and Formatting task pane  is not open, click Styles and Formatting on the Formatting toolbar 

3. Click the style you want in the Styles and Formatting task pane. 

If the style you want is not listed, click All Styles in the Show box 

Track Changes: 

1. Open the document you want to revise.  

2. On the Tools menu, click Track Changes 

Result: Creating a document using MS Word completed successfully by inserting Formatting styles, Bullets and 

numbering, and tables.  

Viva questions: 

1) What is the shortcut keys for creating hyperlink? 

 Ans:Create a hyperlink Cntrl +K 

2)How you can accept or reject track changes in word 2013? 

Ans:To accept or reject track changes in word 2013, 

 Select the track changes made in the document 

 From the review tab, click the Accept or Reject command, the mark-up will disappear and word will 

automatically jump to the next change 
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3)What is the extension of Microsoft Word file? 

Ans:The extension of word 2003 file is .doc and for word 2007 .docx 

4)How to insert foot note to your document ? 

Ans:  Click Insert → Reference →Footnote 

5)What is the shortcut key to open a new document 

 Ans:CTRL+N 

6) What is the function of Menu Bar? 

Ans: Menu Bar displays the menu; we use the menus to give the instructions to the software. 

7) Point out different types of Scroll Bars? 

Ans: Different Scroll Bars are Horizontal Scroll Bar and Vertical Scroll Bar. 

8) What is a Status Bar? 

Ans: Status Bar provides information as current page, current section, total no of pages, inches from the top of 

the page, current line number and column number. 

9 ) How can you justify the text in MS- Word? 

Ans: To justify the text you can click on Justify option in Styles and Formatting Tool Bar or Press Ctrl+J. 

10) What is the function of spell check? 

Ans: The spell check function is used to spell check a series of words 

11)How can you insert a table? 

Ans:Go to insert tab ,click on table option and select required number of rows and columns 

 

12)Define header, footer ? 

 Ans: Headers and footers are pieces of text that appear at the top and bottom of a page 

 

13)Explain about clipart ? 

 Ans: Clip art is a picture or graphic that can be inserted into a word processed document. Clip art comes in a 

wide variety of formats and styles. 
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14)What are the formatting styles in word 

 Ans: font style, size, or color, alignment, line spacing, or indentation. 

 

 15) How can we add borders and shading to paragraphs? 

Ans: a) Select the area of text where we want the border or shading. 

         b) Click the Borders Button on the Paragraph Group on the Home Tab. 

         c) Choose Borders and Shading. 

 

16)What is foot note ? 

Ans: A footnote is a note that appears at the bottom of a page that is commonly used by writers to cite other 

authors publication in their document1 

17)How to change the text direction ? 

Ans:  select the cells for which you want to change the text direction and click the Layout tab under Table 

Tools. Click Text Direction in the Alignment section of the Layout tab 

18)How to align the cell ? 

 Ans: Select the cells, columns, or rows, with text that you want to align (or select your entire table). Go to the 

(Table Tools) Layout tab. Click an Align button. 

19) How to add bullets and numbers to a document ? 

 Ans: Position the cursor where you want to insert the number list. Either click on the number button 

or bullet button 

20)What is the short cut key to add foot note  ? 

 Ans: ALT+CTRL+F 
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PROBLEM 12: 

Create a Newsletter. Features to be covered:-Table of content. Newspaper columns, Images from files and clipart, 

Drawing toolbar and Word Art, Formatting Images, Textboxes and Paragraphs and Mail Merge in Word. 

AIM: To create a news Letter and Mail Merge 

Hardware Requirements: Personal Computer 

Software Requirements: Operating System, MS Office Package (MS- Word Application) 

THEORY: 

 Table of contents: 

  Table of contents displays a list of headings in a created document. It basically provides an outline of the 

entire document created 

 Newspaper columns: 

  One can create a newspaper columns document by specifying the number of new letter-style column 

required and then adjust their width, and add vertical lines between columns. 

Images from files and clipart: 

  Inserting a picture (graphic) from a file and clipart may be required for a document. This picture could be 

a scanned photograph or any other digitally produced one. This picture can be modified, resized, cropped and enhanced. 

 

 

 

 

 

Drawing toolbar and Word Art: 

  One can create his/her own drawings in Microsoft word. Ms Word provides a full fledged drawing tool 

bar. 

  Word Art in Microsoft word enables you to create special and decorative text. 
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Formatting Images, Textboxes and Paragraphs: 

  Formatting an image includes selecting appropriate color, size, layout and cropping. 

  Generally the text in a document follows a standard orientation (line after line). A text box provides a 

different orientation to the text with in a document. It can arrange the text in anywhere and can be resized and moreover 

moved to any section of the document or even outside. 

  When you are formatting a paragraph, you do not need to highlight the entire paragraph. Placing the 

cursor anywhere in the paragraph enables you to format it. After you set a paragraph format, subsequent paragraphs will 

have the same format unless you change the format. 

Mail Merge: 

 It helps us to produce from letters mailing labels envelopes catalogs and others types of merged document. It is so 

found in the tools option on the menu bar. In tools we have letters and mailing. In letters and mailing we have mail merge 

mail merge tool box envelopes tables and letters wizard. In mail merge select the required document you are working on. 

A window for customizing the data base structure appears. This file contains the names, address details with contact 

numbers etc of people you wish to send the letters. 

 

 

PROCEDURE: 

Table of contents: 

1. Click where you want to insert the table of contents.  

2. On the Insert menu, point to Reference, and click Index and Tables.  
3. Click the Table of Contents tab.  

4. To use one of the available designs, click a design in the Formats box.  

5. Select any other table of contents options you want.  
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Newspaper columns: 

1. Select the entire or part of document to be converted into a newsletter-style 

2. Click on format menu, select columns 

3. Any desired number of columns are presets-one or two or three or left or right b\can be selected. 

4. Width and spacing can be fixed and equal columns width can be checked for uniformity 

5. If newspaper columns are to be separated by a line, then check line between 

6. Under apply to will be whole document if entire document is selected else we have to select a selected text. 

7. Click ok 

Inserting images from files and clip art: 

1. Click where you want to insert the picture.  

2. On the Insert menu, point to Picture, and then click From File.  

3. Locate the picture you want to insert.  

4. Double-click the picture you want to insert.  

CLIP ART: 

1. On the Insert menu, point to Picture, and then click Clip Art.  
2. In the Clip Art task pane, in the Search for box, type a word or phrase that describes the clip you want or 

type in all or some of the file name of the clip.  

3. To narrow your search, do one or both of the following:  

 To limit search results to a specific collection of clips, in the Search in box, click the arrow and 
select the collections you want to search.  

 To limit search results to a specific type of media file, in the Results should be box, click the 

arrow and select the check box next to the types of clips you want to find.  

4. Click Go.  

5. If you don't know the exact file name, you can substitute wildcard characters for one or more real 

characters. Use the asterisk (*) as a substitute for zero or more characters in a file name. Use the 

question mark (?) as a substitute for a single character in a file name. 

6. In the Results box, click the clip to insert it.  

Drawing Toolbar and Word Art: 

1. Click in your document where you want to create the drawing.  

2. On the Insert menu, point to Picture, and then click New Drawing.  

A drawing canvas is inserted into your document. 

3. Use the Drawing toolbar to add any shapes or pictures that you want.  
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WORD ART: 

1. On the Drawing toolbar, click Insert WordArt .  

2. Click the WordArt effect you want, and then click OK.  

3. In the Edit WordArt Text dialog box, type the text you want. 

4. Do any of the following:  

 To change the font type, in the Font list, select a font.  

 To change the font size, in the Size list, select a size.  

 To make text bold, click the Bold button.  

 To make text italic, click the Italic button.  

Formatting Images: 

1. Formatting of the images can be achieved by selecting the image and double click on the picture, format picture 

dialog box appears. 

2. The same can be achieved by selecting the tools menu > customize>tool bars tab>picture and click close. 

Basic formatting features of an image 

Resize a drawing 

1. Select the drawing canvas 

2. On the Drawing Canvas toolbar, do one of the following: 

o To make the drawing canvas boundary larger without changing the size of the objects on the 

canvas, click Expand . 

o To make the drawing canvas boundary fit tightly around the drawing objects or pictures, click Fit 

. 

o To scale the drawing and make the objects and canvas proportionately smaller or larger, click 

Scale Drawing, and then drag the edges of the canvas. 

Resize a picture or shape 

1. Position the mouse pointer over one of the sizing handles  

2. Drag the sizing handle until the object is the shape and size you want.  

To increase or decrease the size in one or more directions, drag the mouse away from or toward the 

center, while doing one of the following:  

o To keep the center of an object in the same place, hold down CTRL while dragging the mouse.  

o To maintain the object's proportions, drag one of the corner sizing handles.  
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o To maintain the proportions while keeping the center in the same place, hold down CTRL while 

dragging one of the corner sizing handles. 

Crop a picture 

1. Select the picture you want to crop.  

2. On the Picture toolbar, click Crop .  

3. Position the cropping tool over a cropping handle and then do one of the following:  
o To crop one side, drag the center handle on that side inward.  

o To crop equally on two sides at once, hold down CTRL as you drag the center handle on either side 

inward.  
o To crop equally on all four sides at once, hold down CTRL as you drag a corner handle inward.  

4. On the Picture toolbar, click Crop to turn off the Crop command. 

Text Box: 

1. On the Drawing toolbar, click Text Box .  
2. Click or drag in your document where you want to insert the text box 

3. You can use the options on the Drawing toolbar to enhance a text box— for example, to change the fill color—

 just as you can with any other drawing object 

Paragraphs: 

Change line spacing  

Select the text you want to change. 
1. On the Formatting toolbar, point to Line Spacing, and then do one of the following:  

o To apply a new setting, click the arrow, and then select the number that you want.  
o To apply the most recently used setting, click the button.  

o To set more precise measurements, click the arrow, click More, and then select the options you want 

under Line Spacing.  

Change spacing before or after paragraphs 

1. Select the paragraphs in which you want to change spacing.  

2. On the Format menu, click Paragraph, and then click the Indents and Spacing tab.  

3. Under Spacing, enter the spacing you want in the Before or After box.  

Change paragraph direction 

1. Place the insertion point in the paragraph that you want to change, or select several paragraphs.  
2. Do one of the following:  

o To have text begin from the left, click Left-to-Right on the Formatting toolbar.  

o To have text begin from the right, click Right-to-Left on the Formatting toolbar.  

When you change the paragraph direction, Microsoft Word leaves justified and centered text as it is. In the case 

of left-aligned or right-aligned text, Word flips the alignment to its opposite. For example, if you have a left-to-

right paragraph that is right aligned, such as the date at the top of a letter, clicking Right-to-Left results in a 

right-to-left paragraph that is left aligned. 

Mail Merge: 
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1. Open a document and type the complete body of the letter and format it as required. 

2. Create a data source and choose mail merge from tool bar a window is displayed. 

3. Click on create button and choose from letter options. Then a window is displayed. 

4.  Click active window choose currently active document. Click on data and create data source option. 

5. A window for customizing the data base structure appears and this file contains the names address details with 

contact number etc. we can add or remove fields from this file. 

6. Once the list of fields is finalized a window of same is displayed and types the required file names and click on 

save button. 

7. A window is displayed. Type the details of 10 candidates. After typing details of one person, click on add 

menu. 

8. Click on the o.k. to finish entering the records mail merge tool bar is displayed. 

9. Place the curser at the place where you wish to insert names and click on insert mail merge button. A drop list 

is displayed all fields created would be shown. 

10. By highlighting to desired file and click on it we can insert the field into the main document and go to begin 

the mail merge click on mail merge. 

          11. A window is displayed click once on the merge button to generate letters for all records in your data source file.  

Result: Creating a Mail Merge using MS Word is completed 

Viva questions: 

1. Define undo, redo 

Ans: Redo is a function performed on a computer that does any undo function again. For example, if you 

deleted text and perform an undo 

2. What is the  end notes? 

Ans: footnotes and endnotes in documents to explain, comment on, or provide references to something 

mentioned in a document. Usually, footnotes appear at the bottom of the page and endnotes come at 

the end of the document or section. 

3. How can you print a document? 

Ans: preview your document and specify which pages you want to print. On the File menu, click Print. 

4. How can you make alignment of text in a table? 

      Ans: Select one or more cells in the table, and then click the Table Layout tab.  

       Under  Alignment, click Align, and then select the option that you want. 
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5. How can you insert a picture from another file? 

      Ans: 1.Click where you want to insert a picture in your document. 

       2 On the Insert tab, in the Illustrations group, click Picture. 

       3.In the Insert Picture box, browse to the location of the picture on your  computer, select the    

       picture, and then click Insert. 

 

6. How can you start a mail merge? 

      Ans: 1. In Word, choose File > New > Blank document. 

       2.  On the Mailings tab, in the Start Mail merge group, choose Start Mail Merge, and then      

        choose the kind of merge you want to run. 

7)What is the shortcut key to Redo ? 

 Ans:CTRL+Y 

       8) How can you customize a mail merge? 

       Ans: In a blank Microsoft Word document, click on the Mailings tab, and in the Start          

       Mail Merge group, click Start Mail Merge . 

 

      9).What is a mail merge? 

Ans: Mail Merge is an important functionality in Word 2013, one that has improved across versions 

of Word but remains a difficult thing to do. Word provides a Mailings Tab which contains numerous 

groups and commands useful in Mail Merge, such as the Create, Write and Insert Fields, and Preview 

Results groups. 

 10)What is the main purpose of a drop cap? 

  Ans:  Drop Cap is used to create a large dropped initial capital letter. Select Format-> Drop    

   Cap. 

11)What is the purpose of Bullets? 

Ans: Bullets are used to create Bulleted or numbered list of items.  

12)How can you print a document? 

Ans: Go to File-> Print or press Ctrl+P. 
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13)What is the functionality of Print Layout? 

Ans: In Print layout View we can see the rulers, status bar of the document and displays the fixed page 

length of your document.  

14)What is the use of Clip art ? 

Ans:We can insert any kind of pictures to our document. 

15)What is the use of Word art in ms word ? 

Ans: Word Art in Microsoft word enables you to create special and decorative text. Click  

in your document where you want to create the drawing. 

16)What is the functionality of F7 key 

Ans:It opens the Spelling and Grammar dialogue box  

17)How can we format the images ? 

     Ans: Formatting of the images can be achieved by selecting the image and double  

     click on the picture, format picture dialog box appears. 

18)How to give the space between the paragraphs ? 

       Ans:  

 On the Format menu, click Paragraph, and then click the Indents and Spacing tab. 

      Under Spacing, enter the spacing you want in the before or after box 

19)What is the shortcut key to select the entire document 

Ans: CTRL+A 

20) How to insert a Text box in ms word ? 

Ans: 1.On the Insert tab, in the Text group, click Text Box, and then click Draw  Text Box. 

       2.Click in the document, and then drag to draw the text box the size that you want. 
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PROBLEM 13: 

Creating a Scheduler:-Features to be covered: - Gridlines, Format Cells, Summation, auto fill, Formatting Text 

AIM: To maintain a shift schedule with specifications 

Hardware Requirements: Personal Computer 

Software Requirements: Operating System, MS Office Package (MS- Excel Application) 

 THEORY: 

Microsoft Excel is a proprietary commercial spreadsheet application written and distributed by Microsoft for Microsoft 

Windows. It features calculation, graphing tools, pivot tables, and a macro programming language called Visual Basic for 

Applications. 

 

Tool Bars: 

 

 

 

 Grid lines: 
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1. Click the worksheet. 

2. On the file menu, click page Layout and the go to sheet options. 

3. Click gridlines. 

 

 Format Cell: 

1. Change the font and font size. 

2. Change the text color. 

3. Make selected text or numbers bold, italic or 

underlined. 

4. Create a new style. 

Auto fit: 

1. Combine cells horizontally or vertically to make one large cell. 

2. Add borders to cells. 

3. Shade cells with colors. 

4. Change the column width and row height 

5. Change the font, font size or colors of text. 

6. Align text vertically at the top, center and bottom of cell. 

  Formatting the text: 

1. Select the text you want to format. 

2. On the format menu click cells and then click number tab. 

3. In the catalog box click text. 

4. Enter the numbers in the formatted cells. 

5. Click ok. 

6. Then press enter and reenter the data. 

 

PROCEDURE: 

 First click start button of the screen on status bar. Click on programs and then Microsoft excel. To get a new blank 

work sheet go to programs and then click on excel sheet. On the file menu click page setup and then click sheet tab click 

gridlines. In this way do the required changes using format cell, make the required changes using formatting text also 
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make the required changes. Enter the data in the data in the worksheet consisting of week name person name and timings 

7 a.m. to 3 p.m. Make all the above changes to the text. 

Result: Creating a MS- Excel sheet is completed by inserting grid lines, formatting text options. 

Viva Questions:  

1) What do you mean by a spread sheet? 

Ans: It allows organizing information in rows and columns. 

2) What is the Auto Fill? 

Ans: It allows to quickly filling cells with repetitive or sequential data such as date or numbers or text. 

3) What is a grid line? 

Ans: Grid lines are the border lines of the cells within a spread sheet. 

4) What do you mean by a spread sheet? 

Ans: It allows organizing information in rows and columns. 

5) What is the Auto Fill? 

Ans: It allows to quickly filling cells with repetitive or sequential data such as date or numbers or text. 

6) What is a grid line? 

Ans: Grid lines are the border lines of the cells within a spread sheet. 

7)How to save a file in excel? 

Ans: Click the Microsoft Office Button , and then click Save As. 

 

8)What is formatting tool bar? 

Ans: he Formatting toolbar provides many of the most common options for formatting selected text, such as 

font, font size, font weight, alignment, and color. 

 

9)What is status bar in excel? 

Ans: The status bar at the bottom of Microsoft Office programs displays status on options that are selected to 

appear on the status bar. 
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10)What are the contents of a spread sheet? 

Ans: preadsheets are developed as computerized simulations of paper accounting worksheets. Each cell may 

contain either numeric or text data, or the results of formulas that automatically calculate and display a value 

based on the contents of other cells 

 

11)Describe different types of toolbars available in ms-excel 

Ans:There are two types of tool bars.1.Standard tool bar 2.Formatting tool bar 

 

12)How can you calculate simple formulas in excel? 

Ans: By using Fx function (or) by using Auto sum (or)we can write the formula for addition like this 

=SUM(A1:A4) or =SUM(A1,A2,A3,A4). 

 

13)What is name manager in Excel ? 

Ans:  It define a name for a cell or cell range on a worksheet 

 

 

 

 

 

 

 

 

 

 

 

 

 

https://en.wikipedia.org/wiki/Worksheet#Accounting
https://en.wikipedia.org/wiki/Formula
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PROBLEM 14: 

Calculating GPA-Features to be covered-Cell Referencing, Formulae in excel – average, std. deviation, Charts, 

Renaming and Inserting worksheets, Hyper linking, Count Function, HLOOKUP/VLOOKUP, sorting, & 

Conditional formatting 

i). AIM : To maintain a control chart for printing books with given data. 

Hardware Requirements: Personal Computer 

Software Requirements: Operating System, MS Office Package (MS- Excel Application) 

THEORY: 

Formulae in Excel: 

Go to Formulae Menu and click on Insert Function 

  

Hyper Linking: 

1. Create a worksheet: On the file menu, click new, and then click blank workbook task pane. 

2. Insert a worksheet: C lick worksheet on the insert menu. Right click on sheet tab and then click insert double 

click the template for the type of sheet you want. 

3. Hyperlink:  Using hyperlink we can insert one more sheet in the present sheet 

4. Count function:  Create a blank worksheet press control +c. In the worksheet select cell A and press control +c. 

On the tools menu point to formula auditing and then click formula auditing menu. 

Worksheet: 

1. In the file menu go to menu then a new worksheet is created. 



134 
ITWORKSHOP LAB MANUAL  

                     2 To add a single worksheet, click worksheet on the Insert menu. To add multiple worksheets hold down 

shift and then click the number of worksheet tasks to add in a open workbook 

Sort:  

1. Click a cell in the list you want to sort. 

2. On the Data menu click sort. 

3.  Under first key sort click the custom sort order you 

want and then click ok. 

4. Click any other sorting option you want. 

PROCEDURE: 

Formulae in Excel: 

Mean = (s1 + s2 + s3 + s4 + s5)/5; 

Sample mean = avg (mean) 

Standard deviation = (mean, sample, mean) 

Sample standard deviation= avg (Standard deviation) 

Lower count limit = sample mean – sample standard deviation. 

Upper count limit = Sample mean + Sample Standard deviation 

Conditional Formatting: 

1. Select the cells for which you want to add, change, or remove conditional formatting  

2. On the Home menu, click Conditional Formatting.  

 

  Result: Creating a MS- Excel Sheet is completed by calculating various formulas for the database.  
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Viva Questions: 

1) What is the function of a count? 

Ans: blank entries are not counted, text entries are not counted. 

 

2) What is a Sort? 

Ans: Sorting is to sort the data in ascending and descending order. 

 

3) What is an average function? 

Ans: The average function finds the average of the specified data. 

 

4) What is the syntax of average function? 

Ans: Average (First value, second value, etc); 

 

5) What is a count function? 

Ans: It will return the number of entries in the selected range of cells. 

 

6)What is an average function? 

Ans: The Excel AVERAGE function returns the arithmetic mean of a list of supplied numbers. 

 

7)Explain about chart ? 

Ans: A chart is a powerful tool that allows you to visually display data in a variety of different chart formats 

such as Bar, Column, Pie, Line, Area, Doughnut, Scatter, Surface, or Radar charts. 

 

8)How can you open chart wizard? 

Ans: 1.Select the cells that contain the data that you want to display in your chart. 

       2.Select the Insert Tab. 

       3.Select the Chart type you want to create. 
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9)Explain about chart formatting tool bar ? 

Ans: The formatting toolbar found in most applications with text editing features is used to change the 

format of selected text. 

 

10)How can you resize a chart? 

Ans: 1.To change the size manually, click the chart, and then drag the sizing handles to the size that you want. 

        2.To use specific height and width measurements, on the Format tab, in the Size group, enter the size in the 

Shape Height and Shape Width box. 

 

 

11.List a few important  features of excel 

       Ans: 1.Pivot Tables  2. Conditional Formatting 3. Sorting and Filtering  4. Basic Math   5. Mixed 

Type Charts 

12.Define split cell 

 

Ans: The Split Cells feature allows you to split cells into two or more cells.  

 

13.How can you split a window into a horizontal pane? 

 Ans: Click the short horizontal bar at the top of the right scroll bar and drag the horizontal separator to your 

desired location. Doing so splits the window horizontally. 

 

14.How can you make a freezing pane? 

Ans: 1.Select the row below the row(s) you want to freeze. Click the View tab on the Ribbon. 

2.Select the Freeze Panes command, then choose Freeze Panes from the drop-down menu. ... 

3.The rows will be frozen in place, as indicated by the gray line. 

 

15.How to perform grouping and ungrouping? 

Ans: 1.Select any one of the pictures or objects that were previously in a group. 

2.Under Picture Tools, on the Format tab, in the Arrange group, click Group , and then click Regroup. 
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16).How many types of charts are there in excel ? 

Ans: 1) The Pie Chart 2) The Column Char 3) The Line Chart 4)The Bar Chart 

5)The Area Chart  6)The Scatter Chart and Other Chart Types 

 

17)What is define name ? 

Ans: Create Excel namesthat refer to cells, a range of cells, a constant value, or a formula.  

 

18)What is trace precedence in excel ? 

Ans: Shows arrows that indicate what cells affect the value of the currently selected cells. 

 

19)What is error checking ? 

Ans:Check for common errors that occur in formulas 

 

20)What is Data Validtion in excel ? 

Ans:Prevent invalid data from being entered into a cell 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



138 
ITWORKSHOP LAB MANUAL  

PROBLEM 15 

PPT Orientation, Slide Layouts, Inserting Text, Word Art, Formatting Text, Bullets and Numbering, Auto Shapes, 

Lines and Arrows in PowerPoint. 

TITLE:  

 Create a power point presentation consists of slide layouts inserting text, formatting text, bullets and 

numbering of five slides with following information’s. 

Slide 1 – contents 

Slide 2 – Name 

Slide 3 – Address 

Slide 4 – Hobbies 

Slide 5 – Friends 

AIM: To maintain a PowerPoint presentation with some specifications 

Hardware Requirements: Personal Computer 

Software Requirements: Operating System, MS Office Package (MS- Power Point Application) 

THEORY: 

CREATE A NEW PRESENTATION: 

MS Office Button >> New -- New Presentation window opens up  

 The MS Office Button is located in the top left corner of the Word 2007 Window  

To start a new file from scratch:  

 Choose “Blank Document” and press “Create”.  

There are templates available on the left panel for creating a presentation of a specific type (ie. photo album or 

calendar).  

ADD A NEW SLIDE: 

 Home Tab >> Slides >> New Slide  

 Click on New Slide button. It adds a new slide in the default layout 

"Title and Content.”  

 Click on the arrow at the bottom corner of the New Slide button. You 

can select the slide layout from the Default Design pallet.  

 Click Layout button. You can select and change the slide layout.  
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 Click Delete button to delete the current slides.  

 

FORMATTING SLIDE DESIGN:  

1. Change the Background: 

Design Tabs >> Background >> Background Styles  

 Click on the Format Background button at the bottom.  

 Format Background window appears.  

 You can set the color, solid or gradient, transparency or choose picture/texture fill  

 Click on Close button to apply changes only to the current slide  

 Click on Apply to All to apply changes to all the slide  

2. Change the Theme: 

Design Tabs >> Themes  

 Move the cursor over the theme buttons to preview different themes on your current slide.  

 Click on any theme button to choose the theme, which will be applied to all the slides in your 

presentation.  

 Colors -- Changes the color scheme of the current theme  

 Fonts -- Changes the font of the current theme  

 Effects -- Changes the effects of the current theme  

 

INSERT TEXT:  

 

Home Tab >> Drawing >> Text Box  

In PowerPoint all text is contained in Text Boxes.  

 Click on Text Box button >> Click anywhere in the slide.  

 Drag circle corner points or square side points of the text box to change its size.  

 Click within the box to type text  

FORMATTING TEXT: 

 

Select the text box. The Drawing Tools Tab appears.  
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 Click on the Format tab. Format the selected text box in Shape Styles:  

o Shape Fill -- Changes the fill color  

o Shape Outline -- Changes the color, width, line style of outline  

o Shape Effects -- Applies visual effects (shadow, bevel, etc.) to the text box  

BULLETS AND NUMBERINGS: 

1. Select the lines of text that you want to add bullets or numbering to. 

2. Click bullets or numbering. 

ADD SHAPES: 

Insert Tab >> Illustration >> Shapes  

 Click on the Shape button to see the list of available shapes.  

 Select the shape.  

 Click on anywhere in the slide to insert the selected shape.  

 SLIDE TRANSITIION: 

Slide transitions are animation effects that appear between slides. While they look fancy, these transitions can 

be distracting if overused. It is often good to keep this kind of animation to a minimum.  

Animation Tabs >> Animations >> Transition to This Slide  

Move the cursor over the transition buttons to preview the effects.  

 Click on the Transition effect button to apply the slide transition effect.  

 Click on Transition Sound button to apply sound effect for transition.  

 Click on Transition Speed button to adjust the speed.  

 Click on Apply to All to apply the same transition effect to all the slides.  

Result: Creating MS Power Point presentation by applying animations, transitions, and backgrounds is 

completed. 

Viva Questions: 

1) Explain about power point? 

Ans: Microsoft PowerPoint allows users to combine text, graphics and multimedia into a slide show. While you can use 

the program to create Web pages, teach shapes to kindergartners or help middle school students explore music, its 

main use is as a presentation tool. PowerPoint's slide show replaces technology such a chalkboard or an overhead 

projector to aid someone giving a presentation or leading a discussion. 

2)  What is word art? 

Ans: Word Art is a powerful tool that draws text in all sorts of formats. Sometimes I like to change existing text straight 

into Word Art, which is easy if you know how. 

3) Explain about slide transition? 
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Ans: Slide transitions are the visual movements as one slide changes to another. Many different slide transitions are 

available in programs such as PowerPoint or Open Office Impress. Transitions differ from animations, in that 

animations are the movements of the objects on the slide.      

4) How can you rotate the picture in power point? 

 Ans:  Double click on the picture and you then ribbon will automatically switch to "Format", 

    below it, in the "Arrange" section; you will find the "Rotate" button! 

ii) AIM: 

Hyperlinks, Inserting –Images, Clip Art, Audio, Video, Objects, Tables and Charts 

TITLE: 

 Create a power point presentation consisting of hyperlinks, inserting images, clip art, audio, video objects 

of 4 slides with the following information. 

 Slide 1:- Name of your college in bold letters. 

 Slide 2:- Address of your college in bold letters. 

 Slide 3:- List of all available courses. 

 Slide 4:- Extra co-curricular activities. 

  And apply the transaction effects and set the time three seconds for each slide and view it in slide show. 

AIM: To maintain a PowerPoint presentation using some specifications 

Hardware Requirements: Personal Computer 

Software Requirements: Operating System, MS Office Package (MS- Power Point Application) 

THEORY:  

HYPERLINK:  

1. Select the text or object that you want to represent the hyperlink. 

2. Under insert menu click on Hyperlink. 

3. Under link to, click place in this document. 
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INSERT IMAGES: 

1) Adding Images from File 

Insert Tab >> Illustrations >> Picture  

 Find the picture file you want to insert in the browser window.  

2) Adding images from Clip Art 

Insert Tab >> Illustrations >> Clip Art  

 Search for ClipArt and other media in the right-hand search panel.  

 Check in "Everywhere" box under "Search in" for more extensive results  

 
 

CLIP ART:  

 On the insert menu, point to structure and then click clipart. 

1. In the clipart task pane, in the search for box, type a word or phrase that 

describes the clip, you want to type in all or some of the file menus of the 

clip. 

2. In the results box, click the clip to insert it. 

AUDIO VIDEO OBJECTS: 

1. On the insert menu, go to Media Clips option and select Movie for Video Objects and Sound for Audio 

Objects. 

2. You can select a movie from a file and you can record sound or select a sound or audio from a file. 

 

TABLE: 

1. On the Insert menu, click Table. 

2. Select the size of the Table or you can draw the Table. 

 CHART: 

1. Click the slide where you want to place the embedded object. 

2. On the insert menu, click chart. 
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3. Click a cell on the data sheet and then type the information you want. 

To return to the slide, click outside the chart. 

Result: Creating MS Power Point presentation by applying hyperlinks, images is completed.  

 

Viva Questions: 

1) Define hyper link? 

Ans: Hyperlinks are created with an "href" tag (hyperlink reference). In it's simplest form the tag looks like 

this: 

Ex::<a href="page1.html">Go To Page 1</a 

2) Define slide show? 

Ans: Slide shows have come a long way since those shown on the slide projectors of old. Many digital presentations, 

such as those created in PowerPoint or Open Office Impress are composed of several slides. 

The slide show can be enhanced using transitions and animations. Music, sounds or narration can be added 

to these slide shows and they can run unattended by using custom timings. The slide show is most often 

projected on a screen using a digital projector. 

3) Define slide transition? 

Ans: A slide transition is the visual motion when one slide changes to the next during a presentation. By default, 

one slide simply replaces the previous one on screen, much the same way that a slide show of photographs would 

change from one to the next. 

4) What is animation? 

Ans: Animations in Microsoft PowerPoint refer to the way that items, such as text boxes, bullet points or 

images move onto a slide during a slide show. There are two types of animations available in PowerPoint - 

Preset Animation Schemes, that affect all of the content on a slide, and Custom Animations, that allow you 

to apply a variety of animation effects to individual items on a slide. 
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TASK 19: 

Master Layouts (slide, template, and notes), Types of views (basic, presentation, slide slotted, notes etc), Inserting – 

Background, textures, Design Templates, Hidden slides. 

TITLE: 

 Create a power Point presentation on business by using master layouts and see the presentation in different 

views. 

AIM: To maintain a power point presentation with some specifications 

Hardware Requirements: Personal Computer 

Software Requirements: Operating System, MS Office Package (MS- Power Point Application) 

THEORY:- 

 SLIDE MASTER LAYOUTS:-   

 

View Tab >> Presentation Views >> Slide Master  

 Slide Master Tab appears on the left-hand side of Home Tab  

Edit the Slide Master:  

Click on Slide Master Tab provides a set of Slide Master formatting groups:  

 Edit Master  

 Master Layout  

 Edit Theme  

 Background  

 Page Setup  

 Close -- Click on Close button to go back to Normal View.  

 SLIDE SHOW: 
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1. On the slides tab in the normal view, select the slides you want to set the things for. 

2. On the Animations menu, click side transition. 

3. Under advance slide, select the automatically after checkbox, and then number of seconds you want the slide 

to appear on the screen. 

4. And then click on Slide Show option from view menu or press F5 Key from keyboard.  

PROCEDURE: 

 First click on start button. Then click programs, and then power point presentation. Then select file menu and 

click on new. Then you get a new blank presentation. Then in the first slide, enter the title as business and give product 

name as sub title. Then insert the second slide. Then enter the title as about the product and give description as sub title. 

Then insert the third slide and enter the title as sales about product and enter something about it sales. In this way, 

complete the three slides. Then click on view and then master and then enter date in the space provided for footer. Then 

you find these two in all slides and then again go to view and click on slide show. 

Result: Creating Master Layouts using MS Power Point is completed. 

 

Viva Questions: 

1) Explain about power point? 

Ans: Microsoft PowerPoint allows users to combine text, graphics and multimedia into a slide show. While 

you can use the program to create Web pages, teach shapes to kindergartners or help middle school 

students explore music, its main use is as a presentation tool. PowerPoint's slide show replaces technology 

such a chalkboard or an overhead projector to aid someone giving a presentation or leading a discussion. 

2)  What is word art? 

Ans: Word Art is a powerful tool that draws text in all sorts of formats. Sometimes I like to change existing 

text straight into Word Art, which is easy if you know how. 

3) Explain about slide transition? 

Ans: Slide transitions are the visual movements as one slide changes to another. Many different slide 

transitions are available in programs such as PowerPoint or Open Office Impress. Transitions differ 

from animations, in that animations are the movements of the objects on the slide.      
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4) How can you rotate the picture in power point? 

 Ans:  Double click on the picture and you then ribbon will automatically switch to "Format", 

    below it, in the "Arrange" section; you will find the "Rotate" button. 

   5)Define hyper link? 

Ans: Hyperlinks are created with an "href" tag (hyperlink reference). In it's simplest form the tag looks like 

this: 

Ex::<a href="page1.html">Go To Page 1</a 

   6)How to set time automatically for the slide show ? 

    Ans:There is option Automatically after on animations tab.Set the time and click on  

    automatically after. 

7)Define slide show? 

Ans: Slide shows have come a long way since those shown on the slide projectors of old. Many digital 

presentations, such as those created in PowerPoint or Open Office Impress are composed of several slides. 

The slide show can be enhanced using transitions and animations. Music, sounds or narration can be added 

to these slide shows and they can run unattended by using custom timings. The slide show is most often 

projected on a screen using a digital projector. 

 

 

 

8)How to apply transition sound to the Presentation ? 

Ans:On Animations tab there is Transition sound option, select any one of the sound. 

 

9)Define slide transition? 

Ans: A slide transition is the visual motion when one slide changes to the next during a presentation. By 

default, one slide simply replaces the previous one on screen, much the same way that a slide show of 

photographs would change from one to the next. 

 

10)What is animation? 

Ans: Animations in Microsoft PowerPoint refer to the way that items, such as text boxes, bullet points or 

images move onto a slide during a slide show. There are two types of animations available in PowerPoint - 

Preset Animation Schemes, that affect all of the content on a slide, and Custom Animations, that allow you 

to apply a variety of animation effects to individual items on a slide. 

 

 

 

 

 

 



147 
ITWORKSHOP LAB MANUAL  

REFERENCES: 

1. Introduction to Information Technology, ITL Education Solutions limited, Pearson Education. 

2. LaTeX Companion – Lesile Lamport, PHI/ Pearson. 

3. Introduction to Computers, Peter Norton, 6/e Mc Graw Hill. 

4. Upgrading and Repairing, PC’s 18th e, Scott Muller QUE, Pearson Education. 

5. Comdex Information Technology course tool kit Vikas Gupta, WILEY Dreamtech. 

6. IT Essentials PC Hardware and Software Companion Guide Third Edition by David Anfinson and Ken 

Quamme. – CISCO Press, Pearson Education. 

7. PC Hardware and A+Handbook – Kate J. Chase PHI (Microsoft). 

WEB SITES: 

www.google.co.in 

http://en.wikipedia.org/wiki/Main_Page 

http://www.gcflearnfree.org/office2007 

http://www.w3schools.com  

 

 

 

 

 

 

 

 

 

 

vii 

http://www.google.co.in/
http://en.wikipedia.org/wiki/Main_Page
http://www.gcflearnfree.org/office2007
http://www.w3schools.com/

	LEARNING OUTCOMES
	On the successful completion of the lab student will be capable of
	1. Be able to build their own PC and able to solve Software and Hardware problems.
	2. Demonstrate proficiency in Microsoft Office and Windows.
	3. To acquire hands-on experience in OS installation.
	4. Be able to assist in the creation of an effective  Power point presentation.
	5. Be able to assist in the creation of an effective  Excel sheets.
	7) What is a web browser?
	9) What are HTTP and HTTPS?
	10)  What is SSL (Secure Sockets Layer)?
	11) What is your definition of the term Cross-Site Scripting? What is the potential impact to servers and clients?
	12) Which is the fastest web browser?
	13) A website says I have spyware, is it true?
	14) What is Cross-Site Scripting?
	15) What is hyperlink?
	16) Explain about Opera (web browser)?
	17) Explain about Safari (web browser)?
	18) Have you any idea about Netscape?
	19) What you know about Mozilla Firefox?
	20) What is Plug-in?
	21).What are the features used by Web browsers? - Web browser provides text based user interfaces with the features supporting HTML that are rich in many file formats.   - It uses protocols that support the transaction of one form to another form usin...
	22)What are the privacy and security features being provided by web browsers?
	23) What is the support being provided to web browser?
	25). What is the way to clear the browser cache?
	26)What is the use of incognito browsing?
	27).What is the purpose of web browser?
	28).What is the primary function of the Web browsers?
	29).What are the different types of components involved in URI?
	30)A website says I have spyware, is it true?
	6)  What is SEO?
	7)  How many types of SEO, describe?
	8)  Which is the popular tool to track your website visitors?
	9)  What is Organic Search and Organic Search Result?
	10)  What is Black Hat SEO and White Hat SEO?
	11)  What are the backlinks?
	12) What is Googlebot?
	13)  What is robots.txt?
	14)  Where robots.txt file uploaded to hosting directory?
	15)  Can webpage extension effects the SEO?
	16)  What is robots.txt and how it is useful for SEO?
	17)  What do webmaster tools do?
	18)  What are the some popular Search Engines?
	19)  What is keyword stuffing?
	20)  What is Search Engine Submission?
	6) What is semantic HTML?
	7) What is image map?
	8) How to insert a copyright symbol on a browser page?
	9) How do you keep list elements straight in an HTML file?
	10) Does a hyperlink only apply to text?
	11) What is a style sheet?
	12) Can you create a multi colored text on a web page?
	13) Is it possible to change the color of the bullet?
	14) What is a marquee?
	15) How many tags can be used to separate section of texts?
	16) How to make a picture a background image of a web page?
	17) What are empty elements?
	18) What is the use of span tag? Give one example.
	19) What is the use of iframe tag?
	20) What is SVG?
	Drop cap: To create a large dropped initial capital letter
	Change paragraph direction
	Ans: 1.Pivot Tables  2. Conditional Formatting 3. Sorting and Filtering  4. Basic Math   5. Mixed Type Charts


